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manual at any time without prior notice; un-authorized modification, copying 

distribution or display is prohibited. All comments, queries or 
suggestions concerning this manual please consult with your local dealer.   
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PRECAUTIONS IN USE 

 For safety concern, please always hold the cutter firmly from the bottom 

when moving it. Do not move the cutter by clasping the depression area on 

both sides. 

                  
 Do not shake or drop the blade holder, a blade tip maybe fly out. 

 During operation, keep away from any moving parts of the cutter (such as 

the carriage, drums). Also be careful that your clothing and hairs do not be 

caught. 

 Always connect the power cable to a grounded outlet. 

 Always use the accessory power cable that is provided. Do not wire the 

power cable so that it becomes bent or caught between objects. 

 Do not connect the power cable to branching outlet to which other 

machines are also connected, or use an extension cable. There is danger 

of overheating and of misoperation of the machine. 

 Keep the tools away from children where they can reach. 

 Always put the pinch rollers within position of the white marks. 

 

 

Thanks for your purchase of GCC Puma IV Series Cutting Plotter. For 

your safety and to optimize the performance of the Puma IV, please read 

the user manual completely and keep it in a correct location.  
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Chapter 1  General Information 

 

1.1 Introduction 

Puma IV series cutting plotters have been designed to produce computer-generated images 

or perform contour cutting on sheets or rolls of vinyl media.  

 

This manual covers the following models of Puma IV series cutting plotters: 

‧P4-60LX / P4-60 for media width: 70mm (2.76”) ~ 719mm (28.3”) 

‧P4-132LX / P4-132 for media width: 70mm (2.76”) ~ 1470mm (57.87”) 

 

1.2 Package Items 

The package of the Puma IV model contents the items listed below, please check carefully.  

If you find any item missing, please consult your local dealer for further assistance.  

SSttaannddaarrdd  IItteemm  QQuuaannttiittyy  

1. Cutting Plotter 1 

2. Stand Set (for P4-132LX / P4-132 only, optional for P4-60LX / P4-60) 
 2 piece of T-shape stand  
 1 piece of stand beam 
 20 pieces of M6 screws 
 1 piece of M5 L-shape hexagon screw driver 
 1 piece of Installation Guide for Stand Set 

1 

3. Flexible Media Support System Package 

Items 
P4-60LX / 

P4-60 
P4-132LX / 

P4-132 

1 set of Roll Media Flange (2 pieces)  V 

1 set of Roll Holder (2 pieces)  V 

1 set of Roll Holder Guide Bushes (4 pieces)  V 

1 set of Roll Holder Support (2 pieces)  V 

32 pieces of M6 screws  V 

1 piece of M6 L-shape hexagon screw driver  V 

1 piece of Roll Base V  
 

1 
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4. Accessories 
 1 piece of User’s Compact Disk 
 1 piece of AC power Cord 
 1 piece of data cable (USB cable: 3m) 
 1 piece of Ethernet cable 
 1 set of Blade Holder Assembly (Installed in tool carriage of the cutting 

plotter ) 
 1 piece of Blade (Installed in Blade Holder) 
 1 piece of Safe Blade 
 1 piece of Cutting Pad 
 1 piece of Tweezers 
 1 piece of Promise Card 

1 

 

 

1.3 Product Features  

 

The following are the main features of the Puma IV LX / Puma IV series cutting plotters: 

 

‧ Triple-port connectivity provides you with greater flexibility 

‧ Up to 500 gram cutting force  

‧ Up to 1020 mm per second (40.16 ips) cutting speed (at 45° direction) 

‧ Guaranty 5-meter tracking  

‧ User-friendly and multi-language control panel 

‧ Enhanced Automatic-Aligning System for automatic contour cutting 
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1.4 Appearance of Puma IV 

 

1.4.1  The Front View (Figure 1-1) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Control Panel  

14 buttons and 1 

LED and 1 LCM 

showing messages 

and menus. 

Cutting Pad  

provides the protection of 

blade when the blade is 

cutting. 

Tool Carriage 

performs the 

cutting with the 

installed blade or 

pen with AAS 

module.  

 

Grid Drums 

move the media back and 

forth during operation.  

 

Slicer Groove 

cuts off the extra 

media easily along 

this groove. 

Figure 1-1 

Alignment Rulers  

media can be aligned 

with the clear guide line 

marks 

Platen 

provides the surface for 

supporting media while 

cutting 
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1.4.2  The Back View (Figure 1-2) 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Pinch Rollers  

hold the media during cutting. 

 

Lever  

raises or lowers 

the pinch rollers. 

 

Figure 1-2 
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1.4.3  The Whole View (Figure 1-3) 

 

**Stand for Puma IV 60 is an optional item.  

**Stand for Puma IV 132S is a standard item. 

 

 

  

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 1-3 

Roll Holder – holds 

and supplies the roll 

media for cutting. 

 

Roll Holder Guide 

Bushes – serve to 

keep the roll media in 

place when media is 

pulled from the roll. 

 

T-Stand –supports 

the cutting plotter 

body. 

Stand Beam – 

stabilizes the body.  

Roll Holder 

Support – supports 

roll holders. 

T-Stand –supports 

the cutting plotter 

body. 
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1.4.4  The Left-hand Side (Figure 1-4) 

              

 

  

 

 

 

 

 

 

1.4.5  The Right-hand Side (Figure 1-5) 

 

 
 

 

 

 

 

 

 

 

 

Fuse – 3 Amp. 

AC Power Connector 

Power Switch – On when switches to [I]; Off to [O] 

Figure 1-4 

Serial Interface Connector (RS232C) 

used to connect the cutting plotter to a 

computer through a serial interface cable.  

Figure 1-5 

USB Connector 

used to connect the cutting plotter to a 

computer through a USB cable.  

 

Ethernet Connector 

used to connect your cutting 

plotter to a local area network. 
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Chapter 2  Installation 

2.1    Precaution 

 

Notice 1  

 

 Carefully handle the cutter to prevent any injuries. 

 Make sure the power switch is off before installing the cutting plotter. 

 

 

Notice 2   A proper place for installation the cutting plotter 

 

Please select a proper location that meets the following conditions. 

 The machine can be approached easily from any direction. 

 Keep at least 60 cm space in front and behind the machine. 

 Make sure the cutter is placed on a flat, level and sturdy surface 

 The operation temperature should be between 15 and 30℃ (60-86oF) in the workshop. 

 Keep the relative humidity between 25% and 75% in the workshop. 

 Protecting the machine from dust and air current. 

 Preventing the machine from direct sunlight. 

 

 

Notice 3   Connecting the Power Supply 

 

Check the plug of the power cord to see if it matches the wall outlet. If not, please contact 

your dealer. 

 Insert the plug (male) into a grounded power outlet. 

 Insert the other end (female) of power cord into the AC connector of cutting plotter. 

 

 

Notice 4  Tightening or Loosing Screws with Screwdriver 

Whether manual or electric screwdriver, be careful not to use excess torque force when 

tightening or loosing screws. When tightening or loosing iron and stainless steel screws, 

please refer to the following screw torque standard table, other materials screws are not 

included. 
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Screw 
diameter 

Torque value (kgf-cm) 

Torque standard for high hardness materials  

M3 6 

M4 16 

M5 30 

M6 50 
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2.2  Stand & Flexible Media Support System (for P4-132LX / P4-132) 

 

Please follow procedure below to assemble stand and media support system. 

 

Step 1 Please examine supplied items in the accessory box of stand carton before you 

install:  

Stand is a optional item for Puma IV 60 LX / Puma IV 60, Item List： 

 2 piece of T-shape stand  

 1 piece of stand beam 

 20 pieces of M6 screws 

 1 piece of M5 L-shape hexagon screw driver 

 1 piece of Installation Guide for Stand Set 

 

Step 2 

 Remove the plotter body and the accessories from the shipped carton. 

 Place the stand beam upright on the T-stand and follow the number  to 

assemble (See Figure 2-1 & 2-2). 

 There is hexagon socket head screws fasten on the T-stand on both side taken as 

locating pins. 

 

 

 

 

 

 

 T-Stand 

 Stand beam 

Figure 2-1 

Figure 2-2 
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Step 3 Position the stand beam perpendicularly to part and put the screws into the holes 

and tighten them as Figure 2-2. Then the complete picture of stand will be like Figure 2-1. 

 

 

Step 4 Remove the cutting plotter from the carton. Position your stand under the plotter, 

on the bottom of the plotter, there is one hole on each side in the position corresponding to 

the locating pins, so the locating pins can be located into the holes. Then insert the screws 

into the holes on the stand to fix the plotter and tighten them up as shown in Figure 2-3. 

 

 

 

 

 

 

 

 

 

 Stand beam 

Screws 

Figure 2-3 
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Step 5 

Insert the roll holder support with the screws into the holes of the stand, and then tighten 

them up as shown in Figure 2-4. You could decide roll holder support’s position by inserting 

into different holes.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 6 

Place two roll holders onto the roll holder support and ensure the white protrusion is 

wedged in the groove. (Figure 2-5)  

 

 

 

 
Roll holder 

support  

3 screws 

Figure 2-4 

Roll holder 

support  

4 screws 

Figure 2-4 

Roll holder support 

Roll holders 

Figure 2-5 
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Step 7 

Lastly, the complete picture will be shown like below. (Figure 2-6) 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 2-6 
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2.3    USB Cable Tie and Saddle 

 

The USB cable tie and saddle assembly for the stands with Flexible Media Support System 

only. 

 

Step 1 Insert the cable tie into the upper hole of cable saddle from bottom to top. 

        This side up 

 

Step 2 Place the USB cable into the cable tie and tighten the cable tie. 

  

 

Step 3 Insert the cable tie end into the lower hole of cable saddle to finish the job. 

  
Untied way: pull out the cable tie pull up the pin release the cable tie. 
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 Pull out the cable tie 

 Pull up the pin 

 Release the cable tie 
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2.4    Desktop Flexible Media Support System (for P4-60LX / P4-60 

only) 

 

Step 1 

Check three spacer supports on the back of the machine.  

 

 

 

Step 2 

Insert the left and right roll holder base into the spacer supports on the left and right side 

when 2 inches roll media is used.  
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Step 3 

Press the roll holder base and the installation is complete. 

 

 

 

Note: Insert the left roll holder base into the middle spacer support and right roll holder 

base into the right one when 1 inches roll media is used. 
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2.5  Blade Installation 

 

! Caution 

 

Do not touch the tip of the blade by your fingers.  

 

 

! Notice 

The blade is a consumable item, which will affect the cutting quality significantly. Please 

replace with a new blade when having the following situations: 

1. The tip of blade is broken. 

2. The cutting traces are not as good as they were. 

3. Uncut area remains the same even the blade force has been raised significantly. 

 

Figure 2-11 is the picture of the blade holder. Insert a blade into the bottom of the blade 

holder. Pushing the pin on the top of blade holder can remove the blade. Be sure to keep 

your fingers away from the blade tip.  

 

 

 

 

Figure 2-11 

Pin 

Adjustment depth knob 

Outward ring 
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Step 1 Install blade. (Figure 2-12) 

 

 

 

 

 

 

 

 

Step 2 Push the blade to the bottom of the blade holder. (Figure 2-13) 

 

Step 3 Adjust the blade tip to suitable length by rotating “Blade tip adjustment screw” 

clockwise or counterclockwise. (Figure 2-14) 

 

 

 

 

 

 

 

 

 

 

Step 4 Insert the blade holder into tool carriage. Please note the outward ring of the holder 

must put into the groove of carriage firmly (Figure 2-15) and lock the grip. (Figure 2-16)  

 

 

 

 

 

 

 

 

 

 

 

Step 5 Reverse steps mentioned above to remove the blade holder. 

Tips:  

“The proper length” means the blade 

length is about 0.1mm more than 

film’s thickness. For example, if the 

thickness of film is 0.5mm, then the 

blade length is properly adjusted to 

0.6mm and it can completely cut 

through the film layer without cutting 

though the paper backing. 

Figure 2-15  Figure 2-16 

Figure 2-12 Figure 2-13 

Figure 2-14 
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Step 6 Press the push-pin to remove the blade from the blade holder when replacing 

blade. (Figure 2-17) 

Figure 2-17 
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2.6  Cable Connections 

 

Puma IV communicates with a computer through USB (Universal Serial Bus), a Serial 

port (RS-232C) or Ethernet. This chapter shows you how to connect the cutting plotter to 

a host computer and how to set up the computer/cutting plotter interconnection. 

 

!! Notice: When USB connection is enabled, serial port will be disabled automatically.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2.6.1 USB Interface 

Puma IV build-in USB interface are based on the Universal Serial Bus Specifications 

Revision 2.0 (Full Speed). 

 

2.6.1.1 Connecting your GCC cutter 

Turn on the machine. 

Connect the USB connector to the machine and then USB driver will installed 

automatically. It will take a few minutes to find the device. Please DO NOT disconnect the 

USB cable until the installation has completed.  

You can double click the USB icon on the taskbar to make sure the USB device is 

detected. 

 

Figure 2-18 

Serial Interface Connector (RS232C) – 

used to connect the cutting plotter to a 

computer through a serial interface cable.  

USB Connector – used to connect the cutting 

plotter to a computer through a USB cable.  

Ethernet Connector– used to connect your 

computer to a local area network. 
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2.6.1.2 Installing the driver 

Use the USB One-click Installation for quick driver installation. Follow the simple steps 

below for driver setup. 

 

 

 

 

 

Step 1 Put the installation DVD into your CD-ROM. Please make sure that the USB 

device is connected before you start the driver installation. 

 

Step 2 Choose the model you want to install from the driver list and click on Windows 

Driver (Win 7 and Above) (Automatic Detection) or Windows Driver (Win 7 and 

Above) (Manual Selection) to start installing the Driver and AAS plug-in.  

  

 

 

Step 3 Click “Next” to start the driver installation. 

 

 

Step 4 If you were Windows 7 and above users, please click on the red words to instruct 

you how to disable Windows Update to allow success driver installation. And then 

click OK to next step. 

Caution!! 

 If you are using Windows 7 and above as your operating system, 

make sure you log in using the “Administrator” account. 
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Step 5 Please make sure the cutting plotter is powered on and connected to theUSB 

device, and then click OK to next step. 

   

 

Step 6 Confirm to close all running application programs before you start installing the 

driver, and then click OK. 

 

 

Step 7 The installation will take a few minutes to complete and you will see a message 

below and click on “OK” upon completion. Enjoy your GCC cutter! 

 

 

Step 8 If you want to install AASII VBA on CorelDRAW and Adobe Illusatrator, exit 

CorelDRAW and Adobe Illusatrator program, and then click on“Install.” 
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Step 9 Check Install Message to confirm CorelDRAW and AI version and then click OK. 

 

Note: 

If the driver is being installed for a second time, the user will be prompted as to whether a 

second copy of the driver installation is required. 

 

 

 

 

If the user selects yes, a second copy of the driver will be installed. 

     

 

(3) For users who have upgraded Adobe Illustrator or CorelDRAW, please go to the AAS 

Installer page in the Printer Properties window and click “Install” to access the latest 

version of GCC AAS Plug-in. 
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2.6.1.3 Driver Un-installation 

 

You have to remove previous version driver installed on your PC system completely 

before you can install the latest version successfully. Please refer to below steps.  

 

 

Step 1 Go to Control Panel\Hardware and Sound\Devices and Printers window. Right 

click the printer and select “Remove device.” 
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Step 2 After removing the unit, click on any printer on the page and select “Print 

server properties.” (For Win 7and above) 

Or right click on blank space and then select “Print server properties.” (For 

Windows XP) 

 

 

Step 3 Select “Driver” page 
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Step 4 Select the model and click on “Remove”. 

 

 

Step 5 Select “Remove driver and driver package” and click OK. 

  

 

Step 6 Click Yes and then click “Delete” and “OK,” and the driver installed on PC is 

completely removed. 
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2.6.2 RS-232 Interface 

 

 Connecting to the RS-232 (Serial) Port  

1. For IBM PC, PS/2 users or compatibles, connect the RS-232C cable to the serial 

connector of the assigned serial port (COM1 or COM2) of your host computer.  

2. Set up the communication parameters (Baud Rate and Data Bits/Parity) to match the 

setting of software package, refer to chapter 3 – “Misc” key description.  

 

 

 

2.6.3 Ethernet Connection 

 

I. Networking Connectivity Setup 

 

Step 1 Connect the LAN port and Ethernet port on GCC cutting plotter with RJ45 Ethernet 

cable, and turn on the machine. 

   

Caution!! Please turn off the plotter before plugging the RS-232C 

cable. 

 



                             _________               Puma IV User Manual 

Installation                                   2-22 

 

Step 2 Press On/Off line and then MISC button on your control panel. 

  

 

Step 3 Go to the DHCP page and select Enable through the up and down arrow keys, 

then press Enter. 

     

 

Step 4 The IP Address will be shown on the screen automatically. Please make notes of it. 

  

 

 

 

 

II. Ethernet Connectivity Setup  
 

There are two ways to output your plot through Ethernet. If you output your plot through 

GreatCut, please follow the instruction I. Output through GreatCut; if you output your 

plot through Adobe Illustrator or CorelDRAW, please follow the instruction II. Output 

through the Ethernet Driver. 

I. Output through GreatCut 

 

GreatCut is a plug-in for CorelDRAW and Illustrator. (GreatCut installation please refer to 

chapter 2.9.1) 

 

1 

2 
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Instruction of Ethernet settings for GreatCut 

 

Step 1 Open GreatCut and create a new file and cutting line. 

 

Step 2 Go to Output Devices under Settings. 

 

 

Step 3 Select a model at Driver in Setup Device window 

 

Step 4 Input the IP address you had acquired from the control panel to the TCP/IP. Click 

OK to complete settings. 
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Step 5 Go to Output under File to check the settings. 

  

 

Complete the driver installation process and your GCC Cutting Plotter is now allowed to 

network. 

 

Note: If you want to add new local device, please go to Output Devices under Settings, 

and press the button on the right of Current Output Device and select Add local 

device (if the device has been installed but you wanted to output through another 

device, please select Change to set the IP address of another device). 
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II. Output through Ethernet Driver 

 

Step 1 Connect Ethernet cable to PC and install Cutter Ethernet driver. Then click OK to 

continue. 

 

 

Step 2 Enter the IP Address shown on the control panel and select the model. (Please 

refer part 1 instruction.) 
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Step 3 The driver is installed. You can output from AI or CorelDRAW directly now. 

  

 

2.6.4 Data Transmitting  

There are two options to transmit the data from the computer to the cutting plotter:  

 

Option 1: With proper interface settings, the data can be transmitted from your application 

software package to the cutting plotters directly.  

 

Option 2: Most cutting software packages are able to emulate HP-GL or HP-GL/2 

commands. As long as the file is HP-GL or HP-GL/2 format, the cutting plotter 

can output the data precisely. 

 

2.6.5 Printer Sever Shared Setting 

In “A-PC”, set the printer driver as a shared printer, then use B-PC to connect A-PC’s 

printer driver via Intranet. 

A-PC            B-PC 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 1 Set A-PC’s printer driver as a shared printer (Right-click on printer icon, choose 

“Printer properties”. Click “Sharing” tab then check “Share this printer.”) 

Intranet 

USB or COM 

Port 
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Step 2 Click “Advanced” tab, then choose “Print directly to the printer” option. 

 

 

 

Step 3 Send a job from A-PC to the machine to check if A-PC is connected to the 

machine. 
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Step 4 Activate A-PC’s Printer Driver from B-PC’s Network. 

 

 

Step 5 Right-click on the printer icon, and select “Connect” to A-PC’s printer. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try to send a job 

to check if the 

port is working. 
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2.7 Software Installation 

 

2.7.1  GreatCut Installation 

 

Step 1 Click GreatCut Registration in installation DVD to go 

http://gccvoucher.eurosystems.lu/, and then enter your voucher code provided 

when purchasing GreatCut and click “Go on!” 

 

 

 

Step 2 Click “Request” to go to registration page.  

 

 

Step 3 Fill in the required information and click “Request license code.” 

http://gccvoucher.eurosystems.lu/
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Step 4 The registration is completed; you should receive two emails, one is registration 

confirmation with activation link and another is your license data with .ecf file. 

 

 

Step 5 Check your email to see if you receive the activation link and click the link that will 

direct you the link for GreatCut download. 
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Step 6 Or click “Install GreatCut” in installation DVD. 

 

 

Step 7 Select a destination folder. 

 
 

Step 8 Select Typical and click Next. 

Note: You may select custom setup to install additional drivers. 
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Step 9 Select the folder and click Next. 

Default program folder in the start menu is GCC\GreatCut 3. 

 

Step 10 GreatCut is installing. 

 

Step 11 Click Finish to complete installation. 
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Step 12 Before you launch GreatCut, open the .ecf attached to the license data email to 

install your license data to GreatCut so that you don’t need to fill in your 

information again. 

 

 

Step 13 If the license do not install successfully, you will need to fill in your license data 

manually. You can find the details of your license data from the email. 
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Step 14 GreatCut is ready to use now. 

  

 

2.7.2  Sure Cuts A Lot Installation (Optional Item) 

2.7.2.1  Auto Installation  

Step 1 Put your installation DVD into your CD-ROM to start the installation. The software 

is compatible with Windows 7 and above and Macintosh OSX 10.6 and above. 

 

Step 2 Select “Install Sure Cuts A Lot” to start the installation.  

 

 

Step 3 Press Next to continue.  

 

 

 

Step 4 Select “I accept the agreement” and press “Next.”  
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Step 5 Use the default folder (suggested) or select a folder you want to install the Sure 

Cuts A Lot and press “Next.” 

 

 

 

 

Step 6 Tick “Create a desktop icon” if you want to create a shortcut on your desktop, and 

tick “Associated scut4 extension” to associate the scut4 extension file with Sure 

Cuts A Lot software. Then press “Next” to start the installation.  
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Step 7 Don’t tick “Install USB Driver” and tick “Launch Sure Cuts A Lot,” and then press 

“Finish” to compete installation. 

 

Step 8 Run Sure Cuts A Lot. 

 

 

tep 9 Press “Activate…”to activate Sure Cuts A Lot. Please make sure it is connected to 

the internet.  
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Step 10 Put your name in the Name column and enter the 25-letter software key shown 

on the DVD front cover to the Serial column and press “OK” to complete the 

activation. 

   

 

Step 11 Sure Cuts A Lot is ready to use. 

 

 

 

 

 

 

 

 

 

 

 

Note 

 If you use a trial version to output graphics, meaning you do not enter the 

software key to activate the Sure Cuts A Lot mentioned above, there will 

be two extra lines cut through the design, therefore, make sure the Sure 

Cuts A Lot software is activated before implementing cutting jobs. 
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2.7.2.2 Manually Activate Software 

If the computer connected to cutter doesn’t have internet connection to accomplish above 

software activation process, you can use “Activate manually” function alternatively to enter 

the “Activation Code” to start the usage of Sure Cuts A Lot. Meanwhile, you need to find 

another computer that has internet access to obtain the “Activation Code” in advance 

following below instructions.  

 

Step 1 Check the "Activate manually" checkbox and you should see the Site Code and 

Activation Code fields appear. The Site Code field will be pre-filled in and cannot 

be changed. 

 

 

Step 2 Visit http://www.craftedge.com/activation/surecutsalot via an internet connected 

computer. Enter your name, serial (software key, shows on the DVD cover) and 

site code. 

 

Step 3 Click on the "Generate Activation Code" button, and your activation code will be 

shown in the Activation Code field. 

http://www.craftedge.com/activation/surecutsalot
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Step 4 Copy and paste the activation code back into the activation dialog box of Sure Cuts 

A Lot program and hit ok.  

2.7.2.3 Re-install Sure Cuts A Lot Software 

If you change a new computer, you may need to deactivate your Sure Cuts A Lot software 

and re-install it on your new device.  

 

Go to “Deactivate…” under Help and press Yes to confirm, then follow the installation 

procedure and use the same code to activate it on another computer. 
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Chapter 3  The Control Panel   

 

This chapter describes the button operations with the LCM menu flowcharts of Puma IV. When 

the cutting plotter is ready for use as described in Chapter 1 & 2, all functions are under default 

parameters.   

 

3.1    The LCD Panel 

 
 

< LCD Control Panel on Puma IV series > 

Key Function 

LCD Screen To display functions and error messages. 

Power LED To indicate the power status ( light up: power on; light off: power off ) 

4 Arrow Keys To move position, select function, or change setting. 

ENTER To set item or register the immediately preceding input value. 

PAUSE/RESUME To temporarily halt cutting process or to continue 

ON/OFF LINE To switch modes, stop cutting job, or abort changes of settings. 

OFFSET To adjust the value of blade’s offset. 

FORCE To adjust the value of cutting force. 

SPEED To adjust the value of cutting speed and quality.  

CUT TEST To perform cutting tests on different media 

DATA CLEAR  To clear up buffer memory. 

TOOL SELECT To select tools. 

MISC To set up functions. 

Please see details in “3.4 Menu Items” 
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3.2    Menu in On-line Mode 

Power On    Puma IV (LX) in processing  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Jaguar V 
Firmware:    Copyright: 

 

Place Media And Then 
Lower Down The Lever 

Roll       Edge      Single  

  Key    Key    Key 

Sizing Media Width  
Lever Up To Abort 

 

Sizing Media Length  
Lever Up To Abort 

拨杆 

 

Pause  Setup   Resume 

 

S--- F----- O----  

L-------- W-----T1M 

 

 

Sending data 

 
[PAUSE] 

 
[FORCE] 

 

Force:80 gf 
          OK:ENTER 

 

 

Use    to select; [ENTER] to enable the 

setting 

，按[ 确认 ]保存 

 
[ OFFSET ] 

 

Offset: 0.275 mm 
          OK:ENTER 

 

[ DATA CLEAR ] 

 

Clear Data Memory 
N:ONLINE     OK:ENTER      

 

 [TOOL SELECT ] 

 

Set Smoothing Cut 

Select:      OK:ENTER  

 

 

Top menu 

 

Set Tangential Mode 

Select:      OK:ENTER 

 

 

use        to select 

 

Cutter 
LCM Version- - - 

 

[SPEED] 

key ] 

 

Speed:      72 cm/s 
Select:        OK: ENTER 

 
AAS Speed:       Medium 
Select:        OK: ENTER 

 
Up Accel.:        Medium 
Select:        OK: ENTER 

 
UP Speed:        normal 
Select:        OK: ENTER 

 
Quality:           72 cm/s 
Select:        OK: ENTER 

 

1S:72   F:80  O:0.275 M 
Select:        OK:ENTER 

 

 

OverCut:      0.00mm 
Select:        OK:ENTER 
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3.3    Menu in Off-line Mode 

 

Press [ON/OFF LINE] to switch to the offline mode 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

[ 速度 ] 

 

Offline For System Setup 

 [ DATA] 

CLEAR ] 

CLEAR ] 

 

Clear Data Memory 
N:ONLINE     OK:ENTER     

 

 

     move origin  M  
X:             Y: 

 

 

[         ] 

 

[ OFFSET]

 ] 

 

Offset: 0.275 mm 
          OK:ENTER 

 

 

0.000~1.000 with an increment of 0.025(mm) 

Draft, Fair, Normal, Fine, Small Letter 

 

 

Speed: 3~72 with an increment of 3(cm/s) 

 

[ SPEED ] 

UP Speed:    51 cm/s 
Select:       OK:ENTER 

 

 

UP Speed: 3~72 with an increment of 3(cm/s) 

 

 
Quality:       Normal 
Select:       OK:ENTER 

 

 Up Accel.:       Medium 
Select:       OK:ENTER 

 

 

High, Medium, Low 

 

 

Speed:       51 cm/s 
Select:       OK:ENTER 

 

 

[ FORCE] 

 
5~500 with an increment of 5(gram force) 

 

Force:80 gf 
          OK:ENTER 

 

 

 

Pattern: Cross, Arrow 
Pattern Setting  
Select:         OK:ENTER  

Pattern: Arrow 
Change:      OK: ENTER 

Square Cut 
Select:         OK:ENTER 

[CUT TEST ] 

 

Ratio: 100%, 200%, 300%, 400% 
Ratio Setting  
Select:         OK:ENTER  

Ratio:               100% 
Change:       OK: ENTER 

Repeat AAS Job 
Select:         OK:ENTER After sending AAS job (Puma only) 

Redo Jobs in Memory 
Select:         OK:ENTER 

Recut          #1 
Select:         OK:ENTER 

Copy           #1 
Select:         OK:ENTER 

Recut number: 0-99 

Copy number: 1-999 



                                                          Puma IV User Manual 

The Control Panel                                     3-4 
  

 

(LX model only) 

[ MISC] 

 

Enabled, Disabled 

 

Auto Unrolled Media 
Select:       OK:ENTER 

 

 

Rear Paper Sensor 
Select:       OK:ENTER 

 

 

Enabled, Disabled 

 

Vacuum 
Select:       OK:ENTER 

 

 

Enabled, Disabled 

 

First Back To Origin 
Select:       OK:ENTER 

 

 

DHCP 
Select:       OK:ENTER 

 

 

Enabled, Disabled 

 

IP Address 
Select:       OK:ENTER 

 

 

IP Address set, Submask set, 
Gateway set 

 

MAC Address 
 00:CF:52:72:03:01 

 

Enabled, Disabled 

 

AAS Offset 
Select:       OK:ENTER 

 

 

Section Cut  
Select:       OK:ENTER 

 

 

Offline For System Setup 

OverCut: 0.00~1.00mm with an 
increment of 0.05mm 

[ TOOL SELECT] 

1S:72  F:80   O:0.275 M  
Select:        OK:ENTER 

 

 

OverCut:  0.00mm 
Select:       OK:ENTER 

 

 

Set Smoothing Cut 
Select:       OK:ENTER 

 

 

Set Tangential Mode 
Select:       OK:ENTER 

 

 
Panel Setup 
Select:       OK:ENTER 

 

 
Factory Default ? 
Select:       OK:ENTER 

 

 

AAS Detect Mode 
Select:       OK:ENTER 

 

 

Forward Direction, Auto 
Detection, Reverse Direction 

OFF          

Change:  OK: ENTER 

ON          

Change:  OK: ENTER 

Die/Kiss Cut: ON 
Select:       OK:ENTER 

 

 

 Die/Kiss Cut:                    
Length: 9.0 / 0.2 mm 
 

 Die/Kiss Cut:           
Force:  450 g     45 g 
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Paper Saving Mode 
Select:       OK:ENTER 

 

 Set communication 
Select:       OK:ENTER 

 

 

Select Language 
Select:       OK:ENTER 

 

 Select Unit 
Select:       OK:ENTER 

 

 Scale Length 
Select:       OK:ENTER 

 

 Scale Width 
Select:       OK:ENTER 

 

 

Firmware    x.x.xx 
FPGA: xx.xx 

 

Both Expanded Mode, Length Expanded 
Mode, Width Expanded Mode, Both 

Unexpanded Mode, 

 

English, Francais, Türkce, Polski, Ingles, 
Japanese, Deutsch, Italian, Espanol 

 

Metric (cm/g), Unit (inch/ g),  
Unit (cm/ oz), English (inch/ oz) 
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3.4     Menu Items 

Below describes the functions of menu items 

Menu or Key Function Setting Default 

--- Media sizing --- 

Roll To measure media width. Maximum Tracking 

150 meters 

 

Edge To measure media width and pull the media back till the front 

paper sensor open. 

Maximum Tracking 

150 meters 

 

Single To measure media width and length. Maximum Tracking 

10 meters 

 

--- POWER --- 

 To indicate the power status.    

[ Arrow Keys ] 

  1. To move the tool carriage position on X or Y axis.                                                                   

2. To select functions or change values of settings. 

    

[ ENTER ] 

  1. The displayed parameters will be saved automatically.  

2. To set a new origin at the present tool carriage position. 

In “offline” mode, moving the tool carriage to desired 

position by [Arrow Keys], then press [ENTER] key to set a 

new origin. While moving with the parameters of XY-axes 

displayed, press [MISC] key will enable fine-tune 

movement; press [MISC] key again to disable the function.     

    

[ PAUSE/RESUME ] 

  To temporarily halt the cutting process. 

To resume the process by press [Pause/Resume] key again. 

    

[ ONLINE/OFFLINE ] 

  1. To switch between online mode and offline mode.  

2. To stop the cutting job or abort the change of setting.  

Once press this key, the cutting job will be terminated 

immediately and cannot be resumed. 

    

[ OFFSET ] 

  To set or modify the distance between the blade tip and the 

center axis.  

0.000~1.000mm 0.275mm 

[ FORCE ] 

  To set or modify the value of tool force.  5~500gram;       

5 gram/per step 

80 gram 

[ SPEED ] 

Speed To set or modify tool speed at horizontal moving. 3~72 cm/sec;   

3cm/sec per step 

51cm/sec 

Up Speed To set or modify tool speed while the tool move from endpoint 

to next start point at horizontal moving. 

3~72 cm/sec; 

3cm/sec per step 

51cm/sec 

Quality To set or modify cutting quality. 

[Slower speeds / higher quality - Faster speeds / lower quality] 

 

The Set Cutting Quality Page allows you to adjust and 

balance vector mode’s quality and speed settings based on 

your specific job. Draft Mode offers the highest output speed, 

sacrificing quality. Whereas Quality Mode offers the highest 

quality, sacrificing output speed. Keep in mind that speed and 

quality are usually at a tradeoff. 

Draft, Normal, 

Fair, Fine         

Normal  
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Up Accel. To set or modify tool acceleration levels while the tool move 

from endpoint to next start point at horizontal moving. 

High, Medium, 

Low 

Medium 

[ CUT TEST ] 

Square Cut To perform a cutting test at present blade position.                                                                

For more information, please refer to “4.3 Adjusting the 

Cutting Force and Offset” to adjust blade force and cutting 

speed. 

    

Redo Jobs in 

Memory  

 

 

 

To redo the cut test jobs saved in memory by recutting or 

producing cut test copies. Recut number: 0 means limitless. If 

you want to set number as 0, you should set that between 

repowering the cutter and putting down the lever. 

Recut (number of 

jobs: 0-99)    

 

Copy (number of 

jobs: 1-999) 

Recut 

Repeat AAS 

Job 

To repeat AAS jobs automatically without having to operate 

on the computer side. 

Please be noted that this feature is mainly applied to the 

Single paper mode; please ensure a new piece of material 

you wish to apply this feature on is loaded and the origin 

repositioned to the first registration mark before starting. 

When the first AAS job repeat completes, the user will be 

offered the choice of “Repeat AAS Job Again”, please 

press ”Online/Offline” to return to the main menu. 

This option will appear after finishing reading all registration 

marks (Puma only). 

  

Ratio Setting 

 

To adjust the size of the pattern 100%, 200%, 

300%, 400% 

100% 

Pattern Setting 

 

 

To provide two patterns for cut test 

Note: It is recommended to select “Cross” if you are working 

on thick pieces of materials. 

“Arrow” and 

“Cross” patterns 
“Arrow” 

 

[ DATA CLEAR ] 

  To clear up buffer memory.     

[ TOOL SELECT ] 

Save 

Parameter  

To save pattern(s) of cutting parameters for later use. 

There are 4 sets of parameters saved in the panel. Use Page 

Up and Page Down keys to select the set of parameters you 

wish to adjust, press “Enter” to confirm (the number shown on 

the upper left corner will change accordingly). Each set of 

parameters includes Speed, Force, Offset, Up Speed, Quality 

and Scaling though the latter three will not be displayed in this 

section. To adjust or check individual parameters, go back to 

the responding keys on the panel and press “Enter” to 

confirm.    

Patterns1~4 Pattern 1 

Set Smoothing 

Cut 

To enable smooth-cutting function.   Enable 

Over Cut To generate an overcut to facilitate weeding.  0.00mm-1.00mm      

0.05mm/per step 

0.00mm 

Set Tangential 

Mode 

To enable the emulated tangential-cutting mode for thicker 

media types and small letter cuts.                                                             

Note: while the Offset value setting at 0.000 mm, “Set 

Tangential Mode” will automatically be disabled.  

  Disable 

Panel Setup Accept setup command: 

To accept commands of the Force, Speed, Cutting Quality, 

and Offset only via software. 

   

Control panel only: 

To accept commands of the Force, Speed, Cutting Quality, 

and Offset only via control panel of the cutter.  

  

Factory 

Default? 

To turn all parameters of the menu items to factory-default 

settings.  
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[ MISC ] 

Auto Unrolled 

Media 

To avoid paper jam and motor crash by automatically unroll 

media (50cm and up) before cutting while enabled.  . 

* Auto-unroll only effects on roll/edge media.   

* Using Single mode to size media will disable this function 

automatically. 

* If the length of the rolled media is less than 2 meters or the 

weight is light, it is recommended to set this mode disabled. 

  Enable 

Section Cut To divides the long plot data into sectional output jobs to gain 

higher cutting quality and increase precision.  

Users can set the section by registration marks or input the 

value manually. 

 200mm 

intervals 

Die/Kiss Cut To perform die cut/kiss cut in one cutting line simultaneously 

by designating the outline to green color RGB 255 and 

defining the length and force setting on control panel (Please 

refer to Chapter 4.9 for details). 

 
Length: 0.2 ~9mm 
Force: 45 g~ 450 g      

 

 

Rear Paper 

Sensor 

To detect if the rear paper sensor is covered to determine the 

following process; when it is enabled, the cutter will detect if 

the material has covered the rear paper sensor under the Roll 

and Edge mode; when disabled, the rear paper sensor will 

not be functioning.  

 Note: Rear paper sensor only functions under “Roll” and 

“Edge” mode. 

Enable 

Disable 

Enable 

Vacuum To help improve tracking and cutting accuracy by turning on 

the fans. If you turn off the vacuum system, the fans 

will remain inactive during cutting or plotting. 

 Enable 

First Back to 
Origin 

To enable the carriage back to the previous origin; when 

“Enable” is selected, the carriage will not go back to the 

previous origin while the selection of “Disable” allows the 

carriage to do so. 

Enable 

Disable 

Enable 

AAS Detect 
Mode 

To recognize the printed sheet media is fed in forward 

direction or reversed direction by detecting the registration 

marks.  

1. Forward direction: to detect the registration marks in 

forward media feeding direction 

2. Auto detection: to distinguish the media feeding direction 

automatically by detecting the registration marks. 

3. Reverse direction: to detect the registration marks in 

reversed media feeding direction 

  

DHCP Shows your IP address for TCP/IP Configuration  Disable 

IP Address Shows the IP Address of your cutting plotter.   

MAC Address Shows the MAC Address of your cutting plotter.   

AAS Offset To set or modify AAS offset value. (Puma only) 

You can refer to “5.3 Printer Test” for more details.  

  

Paper Saving 

Mode 

To save media by four different modes:                                       

1. Length expanded mode   2. Width expanded mode                                                           

3. Both expanded mode     4. Both unexpanded mode 

  Length 

expanded 

mode 

Set 

Communication 

To build up the communication between host computer and 

cutter.  

Baud Rate is to determine the speed of data transmission.  

Data Bits refers to the size of one block of data. 

Parity is used to check if data was revived correctly or not. 

9600, n, 7, 1, p  9600pbs, 7 Bits with NO Parity 

9600, o, 7, 1, p  9600pbs, 7 Bits with ODD Parity 

9600, e, 7, 1, p  9600pbs, 7 Bits with EVEN Parity 

9600, n, 8, 1, p  9600pbs, 8 Bits with NO Parity 

9600, o, 8, 1, p  9600pbs, 8 Bits with ODD Parity 

9600, e, 8, 1, p  9600pbs, 8 Bits with EVEN Parity 
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19200, n, 7, 1, p 19200pbs, 7 Bits with NO Parity 

19200, o, 7, 1, p 19200pbs, 7 Bits with ODD Parity 

19200, e, 7, 1, p 19200pbs, 7 Bits with EVEN Parity 

19200, n, 8, 1, p 19200pbs, 8 Bits with NO Parity 

19200, o, 8, 1, p 19200pbs, 8 Bits with ODD Parity 

19200, e, 8, 1, p 19200pbs, 8 Bits with EVEN Parity 

Firmware 

Version 

To display the version number of Firmware and FPGA code.     

Select 

Language 

 To select displayed languages on LCM panel in English, 

Spanish, Italian, Deutsch, Japanese, Portuguese, Polish, 

Turkish or French. 

 English 

Select Units Provide four-unit systems for users convenient. cm/s; inch/oz; 

cm/oz; inch/gram 

Metric 

Scale Length Fixed scaling, for maintenance only.   

Scale Width 
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Chapter 4  Operation 

 

4.1    Media Loading 

 

4.1.1  Loading the Sheet Media 

To load the media properly, please follow the procedures listed below: 

 

Pull the lever upward to raise the pinch rollers. (Figure 4-1) 

 

 

 

Load your media on the platen and slide it under the pinch rollers from either the front side 

or the backside. The alignment rulers on the platen extension will help you to adjust the 

media precisely.   

Note:  

Be sure that the media must be covered by the paper sensors on the platen 

when loading the media. At least one of the two paper sensors should be 

covered. Once the media covers the sensor, the cutting plotter will size width and 

length of media automatically. 

 

Then move the pinch rollers manually to the proper position. Be sure the pinch rollers must 

be positioned above the grid drum. The white marks on top trail will help you position pinch 

rollers when media on the platen. (Figure 4-2) 

Figure 4-1  
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Figure 4-2 

 

 

 

 

 

 

Push the lever downward to lower down the pinch rollers. 

 

Turn on the power; the machine will be initialized. Then follow the instruction of LCM to 

measure the size of the media. 

 

Note:  

Move the pinch roller by applying force at the rear portion of the pinch roller support. Do not 

move it by holding its front rubber roller. 

 

Figure 4-3 correct way to move pinch rollers 

White Marks 
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4.1.2  Loading the Roll Media 

Step 1 

Firstly, put the roll media guide bushes on two roll holders. (Figure 4-4) 

 

 

 

 

 

 

 

 

 

 

Step 2 

Option A (Use the media flange) 

Insert a roll media flange at the end of each roll media and tighten the thumbscrew until the 

roll media is firmly gripped. (Figure 4-5) 

 

 

 

 

 

 

 

 

Then put the roll media on the roll holders. Adjust the position of the roll media ensure that 

the media flange is able to run in the groove of roll holder guide bushes. (Figure 4-6) 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4-4 

Figure 4-6 

Figure 4-5 



                                                          Puma IV User Manual 
 

 

Operation                                         4-4 
 

 

Option B 

Insert the two roll holders into the roll media support set, and then place the roll media 

directly between the two roll holders. (Figure 4-7) 

 

 

Step 3 

Load the media on the platen. After loading the roll media, flatten the media on the platen 

and hold the front edge of the roll media firmly (Figure 4-8) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4-7 

Figure 4-8 
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Step 4 

Then turn the roll downward to make an equal tension across the media. (Figure 4-9) 

 

 

 

 

 

 

 

 

 

Step 5 

Move the pinch rollers to the precise location and be careful that the pinch rollers must be 

positioned above the grid drums. 

 

Step 6 

Push the lever downward to lower down the pinch rollers.  

 

Step 7 

Fixes roll holder guide bushes on the roll holder to secure the roll media.  

 

Step 8 

Turn on the power switch and select Roll, Edge or Single mode appropriate for one time 

setup, or set to Default Roll in Sizing Setting and Roll type sizing will be performed when the 

machine is turned on. Then the cutting plotter is ready to work.  

 

Step 9 

Unloading media：Reversing steps mentioned above to remove the media. 

 

For the users of Puma IV 60 LX / Puma IV 60, you can also use the “Roll Base” (a standard 

accessory of Puma IV 60 LX / Puma IV 60) to feed a roll media. Please adjust the position 

of roll base to get a good cutting result. (Figure 4-10) 

 

 

 

Figure 4-9 

Figure 4-10 
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4.2    Tracking Performance 

 

In order to achieve the best tracking performance for a long plot, please leave the margin of 

0.5mm~25mm in the left and right edges of the media.(Figure 4-11) 

 

 

 

 

 

 

 

 

 

4.3    Cutting Force and Offset Adjustment 

 

Before sending your designs from computer to Puma IV for cutting, please make “Cut Test” to 

adjust cutting force and offset value. 

 

The “Cut Test” should be repeated several times until the optimum settings are achieved. 

 

Please follow procedure below to optimum the cutting force and offset settings. 

 

 

Step 1 

After sizing the media, press [CUT TEST] button to select the “Square Cut”, and press [ENTER 

KEY] to confirm. 

 

The default cutting force and offset value of the cutting test are 80gf and 0.275mm respectively.  

 

Step 2  

Press [ARROW KEY] to move the tool carriage to the position where you would like to cut. Then, 

press the [ENTER KEY] to make a “Cut Test”. 

 

Note: At the same time, the new origin is also set at the cut test position. 

 

Step 3 

When the “Cut Test” is completed, a pattern appears (please refer to Figure 4-12). Peel off the 

pattern to see if it can be easily separated from the media base. If the output result is good, the 

cutting force is set appropriately. If not or it cut through the back paper of media, press [FORCE 

KEY] to adjust the tool force until an optimum force is obtained. 

Pinch roller Pinch roller  

0.5mm-25mm 0.5mm-25 mm 

Figure 4-11 
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Step 4 

If the pattern appears to be BB or CC layout (see Figure 4-12), press [OFFSET KEY] to adjust 

the offset value until AA pattern is shown.

S q u a r e C u t

Press

ENTER_KEY

AA CCBB

Press

ENTER_KEY

E n t e r:O KS e l e c t :

M o v e t t ec u

X Y: :

Ms t

S q u a r e C u t

Press SPEED_KEY,

FORCE_KEY,

OFFSET_KEY to

setup

or

Press arrow keys to

desired position for

next square cut

E n t e r:O K

C o n t

NN : C C E LA

Machine

3mm

8
0
 m

m

3mm

8
0
 m

m

Press

ENTER_KEY

8
0
 m

m

Finish square cut

Press

ENTER_KEY

Press

CANCEL_KEY

i n o u s

Figure 4-12 
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4.4    When Completing the Cutting Job 

 

After completing the cutting job, raise the sheet-loading lever, and then remove the material. 

You can also cut off the finished job by the Safe Blade (a standard accessory) along the knife 

guide. (Figure 4-13)  

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4-13 



                                                          Puma IV User Manual 
 

 

Operation                                         4-9 
 

 

4.5 Puma IV Print Driver setting 

 

4.5.1 Puma IV Print Driver setting > Option Page 

 

Setting: You can adjust the following settings, depending on your application or results you 

would like to achieve.  

 

Quality:  

[Small Letter / Fine / Normal / Fair / Draft] 

The Cutting Quality setting function allows you to adjust and balance vector mode’s quality and 

speed settings based on your specific job. Draft Mode offers the highest output speed, 

sacrificing quality. Whereas Small letter Mode offers the highest quality, sacrificing output speed. 

Keep in mind that speed and quality are usually at a tradeoff. 

 

Use Plotter Setting: 

The parameter settings will be set according to those set from the control panel. 

 

Back to home: 

The carriage will return to the original position when this option is selected.  
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Section Cutting: 

Users can output long picture by section cutting which could make cutting more stable and get 

superior cutting quality. Users can set the section by registration marks or input the value 

manually. When cutting plotter finishing cutting in section 1, it will continue to cut in section 2. 

The picture is shown as below: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

File Function: 

The file function section allows users to set the parameters of Speed, Force, Offset and Quality 

for later use. This section is useful when performing repeated jobs on a variety of objects, 

allowing you to save your frequently used cutter parameters and load them in the future. 

 

• Save: This function will save current print driver parameter settings to a file under the specified 

location on your computer. (Saved parameter setting files will be tagged with the Puma series 

extension)  

 

• Load: This function allows you to load previously saved print driver parameters. 

 

• Original: This function will load the print driver’s original factory parameter settings. 
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• Save To Default: This function allows you to save your current print driver parameters as the 

default startup settings. 

 

• Delete: This function will delete the file you select from the Custom Media section, whereas 

the settings in Default section cannot be deleted. Please note the delete function only 

removes the list shown in Custom Media section, it does not remove the file from your hard 

drive, if you wish to completely remove the file from your hard disk, you will have to manually 

delete the file from your operating system. 

 

• Custom Media: This section lists the files for the parameter settings that you have recently 

created and worked. You can save more than 50 files to simplify your cutting job. 

 

• Default: This section contains the reference settings that are applicable with the verified 

materials to achieve the best cutting results. Please note that the setting value might need to 

be adjusted according to different suppliers of materials. 

 

Die Cut: 

The Die Cut function must be activated with the Kiss Cut function to avoid the falling of 

cut-through materials and material jam beneath the carriage. Die Cut helps you to cut through 

the backing of the material while Kiss Cut cuts through only the top layer but not the backing. 

This will leave only tiny bits of the backing attached to the top layer, creating complete individual 

patterns with backing sheets (see figure 1 and 2).  

 

 

 

 

Cutting line 

Vinyl 

Figure 2 

Figure 1 
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To activate the Die Cut function, go to “Option”, tick “Die Cut”, and enter the amount you wish 

for the “Length” and “Force” of both Die Cut and Kiss Cut, then click “OK” (see figure 3).  

 

 

When the job is completed and you untick the Die Cut function, you will be able to adjust the 

pen speed, pen force, and offset in the section on the top following normal operating procedures 

(see figure 4). 

 

Note:  

The length setting for the 

cutting line of Die Cut is in the 

range of 0-2000mm whereas 

that of Kiss Cut is 0-100mm. 

Figure 3 

Note: the extension of the 

blade has to be set to cut 

through both the top layer 

and the backing in the very 

beginning. You then adjust 

the tool force for the best 

cutting performance. 

Figure 4 
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4.5.2 Puma IV Print Driver setting > Paper Page 

 

 

Paper Size (Paper Page) [DEFAULT SETTING: Y = the width of machine; X will be 

automatically set to be twice the length of Y] 

 

The paper size represents your total work area. The X value represents the length and the 

Y value represents the width. The paper size should be set as the same as your image so you 

can get a better cutting quality. 

 

Unit (Paper Page) [DEFAULT SETTING: Metric (mm)] 

Here you can set your preferred measurement standard in which you would like use with the 

Jaguar V print driver. You can choose between metric or imperial standards. 
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4.6 Reference Parameter setting for different materials  

 

The following reference parameter is used on GCC verified materials shown in the table.  

 

Material  
Personalized/ Wall 

stickers 
Vehicle stickers Window decoration Window tint 

Blade red red red red / yellow 

Blade tip length (mm) 0.28 0.27 0.25 0.09 

Force (g) 105 85 95 70 

Speed (cm/sec) 72 60 65 72 

Offset (mm) 0.25 0.25 0.25 0.25 

Recommend model 
RX, Jaguar, Puma,  

EX, AR 
RX, Jaguar, Puma,  

EX, AR 
RX, Jaguar, Puma,  

EX, AR 
RX, Jaguar, Puma,  

EX, AR 

Material  Stencil Reflective film Flock Cardboard 

Blade red / green green green green 

Blade tip length (mm) 0.3 0.5 0.3 0.3 

Force (g) 180 380 135 165 

Speed (cm/sec) 15 3 30 30 

Offset (mm) 0.25 / 0.5 0.5 0.5 0.5 

Recommend model 
RX, Jaguar, Puma, 

EX, AR 
RX, Jaguar, Puma,  

EX 
RX, Jaguar, Puma, 

EX, AR 
RX, Jaguar, Puma, 

EX, AR 

Material  Magnets Protective tint Rhinestone Sandblast mask 

Blade green green green blue 

Blade tip length (mm) 0.8 0.3 0.8 0.27 

Force (g) 580 320 190 85 

Speed (cm/sec) 3 3 15 60 

Offset (mm) 0.5 0.5 0.5 0.25 

Recommend model RX, Jaguar 
RX, Jaguar, Puma,  

EX 
RX, Jaguar, Puma 

RX, Jaguar, Puma, 
EX, AR 

Material  Small text (vinyl) 

Blade black 

Blade tip length (mm) 0.27 

Force (g) 
thick: 150  
thin: 90 

Speed (cm/sec) 9 

Offset (mm) 0.175 

Recommend model RX, Jaguar, Puma 
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4.7 How to set die/kiss cut through plug-in software for Adobe Illustrator and 

CorelDraw 

 

Die/kiss cut function allows you to define two cutting parameter in one cutting line, you can set 

through plug-in software for Adobe Illustrator and CorelDraw directly instead driver setting by 

designate the line to green color RGB 255 and then set the length and force from the control 

panel. 

 

1. Select an outline that you want to do die/kiss cut in working area.  

 

 

 

2. Change the color to green color code RGB 255 then click “OK” 

(Note: Only green color code RGB 255 is identified as die/kiss cut function, please don’t 

select other color otherwise the function cannot work) 

 

Figure 4-27  

Figure 4-28  
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3. Outline color has been changed to Green. 

 

 
 

 

 

 

4. Select “ On/Off Line” > “MISC”, use arrow key to select “Die/Kiss Cut” function then press 

“Enter”. 

Figure 4-29  

Figure 4-30  
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5. Click the left arrow key to the next page to adjust the length value (0.2mm ~ 9.0mm) then 

click “ENTER”. 

 

 

6. Click the left arrow key to the next page to adjust the force value (45g ~ 450g) then click 

“ENTER” and finish the setting. 

 
 

Figure 4 



                                                         Puma IV User Manual 

Automatic-Aligning System 5-1 

Chapter 5  Automatic-Aligning System 

 

Please note that this chapter is only an instruction to AASII. Puma IV LX models feature AAS 

function, but Puma IV models don’t. If you are Puma IV models user, please skip this chapter. 

For step-by-step instructions, please refer to the following chapters: A-4 CorelDRAW Plug-In, 

A-5 Illustrator Plug-In, A-6 GreatCut Plug-In.  

 

5.1 Introduction 

 

The Puma IV LX models cutting plotters feature a standard Automatic-Aligning System (AAS II) 

to guarantee precise contour cutting quality by detecting the registration marks printed around 

the graphic. 

 

Notice  

 Avoid any kind of light source horizontally illuminating the AAS module.  

                                                                                                                                                                                     

                          

                                       
                        - PROHIBITED                        - ACCEPTABLE 

 

 

 DO NOT take off the cover of AAS module while in operation. 

    

                       - PROHIBITED 
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5.2 AAS Calibrating the System 

 

The AAS system has one calibration procedures to ensure maximum accuracy of AAS 

operation. To operate the AAS you need to learn about the method of media feeding firstly. 

(Refer to 4.1 Media Loading.) 

 

5.2.1 Media Calibration  

Media Calibration is to ensure the sensor being able to recognize the registration marks. 

The factory default works on a wide range of materials. However, certain types of 

materials may not work properly. Performing a media calibration may become necessary 

while working with such materials to change the sensitivity of AAS for greater reliability.  

Media calibration adjusts the media feeding according to media type for better accuracy 

during cutting.  

 

 When to use 

We suggest white media for best cutting result. It is not necessary to perform media 

calibration every time unless the registration marks on the printed media become 

undetectable in AAS sensing process. 

 

5.2.2 AAS Calibration  

The first registration mark is designed to be different in order to identify the origin for AAS 

auto-detection. The following precaution must be aware for registration marks to be read 

automatically. 

 Type of media 

 Registration mark pattern 

 Reading range required for detection the registration marks 

 Position for registration marks and medium 

          The registration marks have to be: 

 Created by cutting software like SignPal or GCC CorelDRAW plug-in 

 In black color (printing quality of registration marks is essential; incorrect, 

misaligned colors, blurry or smeared printout might leading to inaccurate cutting 

result) 

 Length: The length of marks 

 Range: 5mm~50mm 

 Optimized Setting: 25mm 

 Thickness: The line thickness of marks 

 Range: 1mm~2mm 

     Optimized Setting: 1mm 



                                                         Puma IV User Manual 

Automatic-Aligning System 5-3 

 Margin: The distance between marks and images 

 Range: 0mm~50mm 

 Optimized Setting: 5mm 

The cutter can not detect the marks while: 

 Cutter carriage is not located near the outside area of first mark before 

detecting (See the picture in page 5-7 for auto-detecting area of first mark.) 

 Medium thickness is more than 0.8mm 

 Transparent medium is used 

 Non-monochrome drawing. The marks can’t be read if is printed on colored 

medium 

 Dirty or creased medium surface 

 

 

5.2.3 AAS II on Puma IV LX 

There are three types of AAS II mark patterns: 4-Point Positioning, Segmental 

Positioning, and Multiple Copies. Note that before print out your designs by inkjet printers, 

the registration marks have to be created on your graphic designs by cutting software 

like SignPal, EasySign or GCC CorelDraw plug-in. Hand-made marks or drawings won’t 

be reorganized by GCC cutting plotters. For more details about registration mark setting 

in cutting software, please refer to Appendix A-4 CorelDraw Plug-In, A-5 Illustrator 

Plug-In, A-6 GreatCut Plug-In. 

 

1. 4-Point Positioning 

This is the basic mark pattern that AAS II will auto detect four registration marks and 

contour cut images inside those marks. 

 Command: Esc.D1;(XDist);(YDist): 

 Layout: 4 registration marks at the 4 corners around the design 

 

 

2. Segmental Positioning 

In addition to 4 original points, the intermediate registration marks are added on both X 

axis and Y axis to help contour cut accurately, especially for cutting large images. 

 Command: Esc.D2;(XDist);(YDist);(XStep);(YStep): 

 Layout:  
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In-between distance on X: 200~600mm, default 300mm 

In-between distance on Y: 200-600mm, default 300mm            

 

 

3. Multiple Copies 

The function is used to duplicate images to let you cut quantities of images at a time.The 

AAS II sensor will automatically scan registration marks for each individual image to 

ensure the contour cutting precision.  

 Command: Esc.D3;(XCopies);(YCopies);(Space): 

 Layout:                   
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5.3 Printer Test 

 

Before performing AAS contour cutting, it’s recommended to print out a test file that you 

can find in the enclosed Installation DVD to make sure the AAS II cutting accuracy of 

Puma IV. 

  

There are two testing files for AASII: 

1.    AAS II_X_Y_Offset_Caberation_A4 .eps (A4 size) 

2.    AAS II_X_Y_Offset_Caberation_600_600 .eps (Default setting, it is recommended 

for testing) 

  

 Print out the testing graphic. ( Please use high precision printer) 

 Load the graphic to Puma IV LX models and sent the file to test the cutting job 

 If there are any adjustments to be made, you can change the offset value by 

following the steps: 

■ Measure the offset values from the printed line and the actual cutting line. 

■ Enter the AAS Offset under MISC function for the values you just measured, 

then press Enter 

■ Test the cutting again 

■  AAS II offset X and Y value is defined as following:       

Horizontal line is defined as X and vertical is defined as Y (when facing 

the cutting plotter) 

■  When the actual cutting line and the printed line need to be changed towards 

the direction of origin mark, then simply add the negative value of the offset. 

If the direction is from the opposite of the origin mark, then enter positive 

values for the offset (see the following figures). This method applies to both 

X and Y axes. 
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Note:  

 Before adjusting the AAS II settings, please proceed scaling for width and length. 

 The blade offset value isn’t set for this test graphic, please set it according to the 

blade you use. 

 If you have any question, please contact us or your local distributor for assistance. 
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5.4 Registration Mark Offset Range  

Please correctly load your media (refer to the alignment ruler on the platen) to make sure the 

registration marks are successfully detected. Deviation exceeds the range below will lead to 

detection failure. 

 

 

 

 

 

5.5 Contour Cutting 

 

For accurate contour cutting with AAS function, please proceed the following steps: 

 

Step 1 Creating Graphics 

  ■ Create the graphic that you want to print and cut in your software. 

 

 

 

  ■ Create a contour for cutting around the graphic. 

 

 

 

TIPS1: Leave some space between the graphic and contour line. 

TIPS2: Create the contour in a separate layer and assign a different color for it. 

 

        ■ Add registration marks around the graphic. 

 

    Note: 

The Multiple Copies function is also available. It automatically copy the graphic and 

registration marks. 
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Step 2 Placing the Registration Marks 

 The AAS Layout Instruction: 

    * Auto-detection function on the 1st mark covers the grey area 

 Suggested 30mm margin on both left and right sides of media sheet.  

 Suggested 20~30mm margin on top of media sheet, and at least 50mm margin on 

the bottom edge to prevent sheets dropping or any error occurred while media sizing. 

 

Step 3 Print the Graphics  

  ■ Print the graphic and the marks with your printer  

(Scaling = 100%).   

  ■ When printing on a roll media, make sure the orientation as following: 
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Step 4 Load the printout onto cutter 

  ■ The Origin Mark is is different from the rest registration marks. Please make sure the 

media is fed with correct direction. 

              

 

Step 5 Cut the Contour 

  ■ Send out the command from software to perform the contour cutting job. 

 

 

5.6  Tips for AAS 

 

For getting better results of contour cutting, there are some tips below for your reference. 

 

 Keep light sources simple and avoid illuminating from the sides of cutter. 

 Before operating AAS, change the maximum paper size in Puma IV driver 

property. 

Step 1 Find the Puma IV LX model in the “Printer & Fax” folder of your PC. 

Step 2 Open the Properties window and select the “Paper” tab. 

Step 3 Change the maximum Paper Size of X to 1200mm. 

 Adjust the cutting speed to between 300~600mm/sec. 

 Avoid the registration marks locating on the tracks of pinch rollers. 

 Make sure the edge of the media is not bent up when detecting registration marks. 
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Chapter 6  Basic Maintenance  

 

This chapter explains the basic maintenance (i.e. cleaning the cutting plotter) 

required for the cutting plotter. Except for the below mentioned, all other 

maintenance must be performed by a qualified service technician. 

 

6.1 Cleaning the Cutting Plotter  

 

In order to keep the cutting plotter under good condition and best performance, 

you need to clean the machine properly and regularly.  

 

Precaution in Cleaning 

 

 

 

 

 

 

 

Recommended Methods 

 

 Gently wipe the cutting plotter surface with a lint-free cloth. If necessary, 

clean with a damp cloth or an alcohol-immersed cloth. Wipe with water to 

rinse off any residue and dry with a soft, lint-free cloth. 

 Wipe all dust and dirt from the tool carriage rails. 

 Use a vacuum cleaner to empty any accumulated dirt and media residue 

beneath the pinch roller housing. 

 Clean the platen, paper sensors and pinch rollers with a damp cloth or an 

alcohol-immersed cloth, and dry with a soft, lint-free cloth. 

 Wipe dust and dirt from the stand. 

 

   

 

 

 

 

 Unplug the cutting plotter before cleaning  

 Never use solvents, abrasive cleaners or strong 

detergents for cleaning. They may damage the surface of 

the cutting plotter and the moving parts.  
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6.2 Cleaning the Grid Drum  

 

 Turn off the cutting plotter, and move the tool carriage away from the area 

needed to be cleaned. 

 Raise the pinch rollers and move them away from the grid drum for 

cleaning. 

 Use a bristle brush (a toothbrush is acceptable) to remove dust from the 

drum surface. Rotate the drum manually while cleaning. Refer to Figure 6-1 

 

 

 

 

 

6.3 Cleaning the Pinch Rollers  

 

If the pinch rollers need a thorough cleaning, use a lint-free cloth or cotton 

swab to wipe away the accumulated dust from the rubber portion of the pinch 

rollers. To prevent the pinch rollers from rotating while cleaning, use finger to 

hold the pinch rollers not to rotate. 

 

If needed to remove the embedded or persistent dust, use the lint-free cloth or 

cotton swab moistened with rubbing alcohol. 

 

Figure 6-1 

Note: The daily maintenance of your cutting plotter is very important. 

Be sure to clean up the grid drum and pinch rollers regularly for 

better cutting accuracy and output quality. 
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Chapter 7  Trouble Shooting 

 

This chapter is to help you correct some common problems you may come across. Prior to 

getting into the details of this chapter, please be sure that your application environment is 

compatible with the cutting plotter.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Possible Causes: 

 

7.1 Non-Operational Problems 

Check the following first: 

 Does the AC power cord plug in properly? 

 Does the AC power cord connected to the power connector properly? 

 Does the power LED still illuminate? 

 

Solutions: 

 

If the LCM is able to display the message, the cutting plotter should be in a normal 

condition. Switch off the cutting plotter and turn it on again to see if the problem still 

existing. 

 

If the LCM is not able to display any message, contact the technician from your dealer.   

 

Note: 

Before having your cutting plotter serviced, please 

make sure that the malfunction is in your cutting 

plotter, not the result of an interface problem or a 

malfunction in your computer or a software problem.  

Why doesn’t the cutting plotter operate? 
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7.2 Operational Problems 

 

Some mechanical problems or failure during operation will cause some problems. The error 

messages shown on the LCM present the problem first, and followed by recommended actions. 

If the problem still exists after the recommended actions have been done, have your cutting 

plotter serviced.    

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Error, Check Media 

Or Drum or X Motor 

This message indicates that there might be a 

problem on the X axis. Check if the drum is 

working well and if the media is well loaded.  

Correct the problem and re-power on to 

reboot system. 

Error, Check Media  

Or Y Motor  

This message indicates that there might be 

an obstruction to carriage relating to a 

problem on the Y axis.  Correct the problem 

and re-power on to reboot system. 

 

Error, Check Carriage  

Sensor or VC Motor 

This message indicates that the blade 

up/down sensor malfunction. Re-power on to 

re-boot system. If the problem still exists, find 

a serviceman. 

 

Graph Was Clipped. 

Data In Buffer 

This message indicates that the cutting 

exceeds the cutting limit. Reload larger media 

or re-scale the plot to a smaller size; then 

press the key followed by the display of LCM 

to continue. 
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7.3 Cutting Plotter/Computer Communication Problems 

 

The messages showed below present problems in relation to cutting plotter/computer 

communication. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Communication Error 

Setup: MISC. key 

Is the connection cable 

connected to the cutting plotter 

and computer properly? 

Yes No 

Has the interface setting 

been done correctly? 

 

Refer to Chapter 2- 

Connecting your cutting 

plotter. 

Yes No 

Try the communication 

between your cutting plotter 

and computer. If it still does 

not work, have your cutting 

plotter serviced. 

Refer to the “MISC” key in 

Chapter 3 - Description of 

Operation for the port setup.  

If your cutting plotter can not recognize 

the HP-GL/2 or HP-GL commands, please 

check the HP-GL/2 or HP-GL commands 

applied to your cutting plotter are used 

properly.  

Note:  

The computer also needs to set up compatible communication 

parameters to the cutting plotter set up.  

 

HP-GL/2 Cmd. Error 
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7.4 Software Problems 

 

Check the following first:  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Does your software package indicate that it will work with 

your computer and cutting plotter?   

Does your software support HP-GL and HP-GL/2 drivers? 

(* check the configuration settings of your software.)  

Yes No 

Does the cutting plotter interface 

match the requirements of your 

software? 

 

  

Does your 

software 

recommend 

using a different 

cable? 

Does the software 

vendor provide a 

sample file?  

Most well known cutting softwares 

in the world have drivers for our 

cutting plotters. If not, use 

software that has HP-GL and 

HP-GL/2 emulation supports and 

you can chose the following three 

drivers: 

 A3 size: HP7475A 

 A1 size: HP7580A 

 A0 size: HP Draf Pro Exl or 

HP Draf Master 

 

 

 

 

Yes No 

Refer to Chapter 

2 - Connecting 

your cutting 

plotter. 

 

Yes No 

Try using the 

recommende

d cable. 

Yes No 

Re-power on the 

cutting plotter and 

try to send the file 

again. 

Do something about the 

error message display on 

LCM, or consult your 

software vendor. 
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7.5 Cutting Quality Problems 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Is the blade installed correctly and the blade 

holder fastened securely? 

Yes No 

Is the blade dull 

or chipped? 

Yes No 

Replace 

with a new 

blade 

Is tool force set up 

properly? (The default 

for tool force is 80 gf) 

Yes No 

Adjust the tool force to obtain an 

optimum blade force. Refer to 

Chapter 4.3 “Cutting Force and 

Offset Adjustment” 

Is the tool offset set up 

properly? 

Yes No 

Adjust the tool offset to 

obtain an optimum value. 

Is there any dirt adhered to 

the blade? 

Yes No 

Refer to Chapter 2.3 

“ Blade Installation” 

Remove the 

blade and clean 

it. 

Please contact your dealer for 

technician support.  

Note: The daily maintenance of your cutting plotter is very important. 

Be sure to clean up the grid drum and pinch rollers regularly for 

better cutting accuracy and output quality. 
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Puma IV Specification 

 

Model Name/No. P4-60(LX) P4-132(LX) 

Operational Method Roller-Type 

Max. Cutting Width 600 mm (23.6 in) 1300 mm (51.18 in) 

Max. Cutting Length  50 m(164 ft) 

Max. Media Loading Width 719 mm (28.3 in) 1470 mm (57.87 in) 

Min. Media Loading Width 50 mm (1.97 in) 

Acceptable Material Thickness 0.8 mm (0.03 in) 

Number of Pinch Rollers 2 4 

Motor Drive DC Servo Control 

Cutting Force 5~500 g 

Max. Cutting Speed 1020 mm /sec (40.16 ips) (at 45° direction) 

Offset 0~1.0 mm (with an increase of 0.025 mm) 

Mechanical Resolution 0.009 mm (0.00035") 

Software Resolution 0.025 mm (0.00098") 

Distance Accuracy ±0.254 mm or ±0.1% of move, whichever is greater 

Repeatability ±0.1mm within 3 meters (* certified media) 

Automatic-Aligning System 
Available on Puma IV LX models, including Segmental Positioning and 

Auto Rotation functions 

Memory Buffer  32 MB / 16 MB (when using AAS) 

Interfaces USB 2.0 (Full Speed), Serial (RS-232C) and Ethernet 

Type of Command HP-GL, HP-GL/2 

Control Panel LCD (20 digits x 2 lines), 14 Keys, 1 Power LED 

Diameter of Blade 2.5 mm 

Dimension (HxWxD) mm 
220x 879x258 

8.67 x34.61x10.16 in 

1065 x 1632 x 620 (including stand) 

41.93 x62.25x24.41 in  

Net Weight 13kg / 28.6lb 53 kg / 116.4 lb  

Stand Optional Standard  

Power Supply AC 100-240V, 50~60 Hz (auto switching) 

Power Consumption Max.110 watts 

Environment Temperature 15C ~35C / 60°F ~86°F (operating) 

Environment Humidity 25%~ 75% relative humidity (operating) 

 Compatible with Windows 7and above and MAC OS X 10.6 and above. 

 The specification and data sheet may vary with different materials used. In order to obtain the best 

output quality, please maintain the machine regularly and properly. 

 GCC reserves the right to change the specifications at any time without notice. 

 GCC certified material in tracking is Avery MPI 3000. 

 The above listed specification values are effective only when operated with media certified by GCC. 
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Blade Specification 

 

202003480G 

For cutting thick fluorescent and reflective vinyl. Also for cutting 
detailed work in standard vinyl. 

The blade is 45° with Red Cap (5-unit package), 0.25 mm offset, 
and 2.5 mm blade diameter. 

 

290088080G 

For cutting reflective vinyl, cardboard, sandblast, flock, and 
stencil sharp edge. 

The blade is 60° with Green Cap (2-unit package), 0.50 mm 
blade offset, and 2.5 mm blade diameter. 

 

265017550G 

For cutting thin sandblast mask and stencil. The blade with 
sharp angle and special design, allowing it to maneuver around 
sharp corners. 

The blade is 60° with Blue Cap, 0.25 mm blade offset, and 2.5 
mm blade diameter. 

 

265017560G 

For Cutting small text and fine detail. Sharp blade with smallest 
offset. 

The blade is 50° with Black Cap, 0.175 mm blade offset, and 
2.5 mm blade diameter. 

 

265017530G 

For thin and delicate media such as window tint. 

The blade is 25° with Yellow Cap, 0.25 mm blade offset, and 
2.5 mm blade diameter. 
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About the Tool 

 

A generic term referring to the blade that cuts the sheet, the pen that does plotting, and the 

LED bombsight (option) used for pointing to the reference point. 

OFFSET is the distance that the blade tip is displaced from the centerline of the blade. 

 

 

 

 

 

 

                                        

 

 

                   

                                                                  

 

                                                                  

 

 

Protrusion Length of the Blade 
 

 

 

 

 

 

 

 

 

 

 

 

Length of protrusion = t1 + t 2/ 2, but for your convenience you may just make it about 

0.3mm ~ 0.5mm beyond the blade holder tip. 

 

 Central line   

Blade 

  Blade tip 

offset 

Thickness of the 

base paper (t 2) 

Thickness of  

the media (t1) 

Protrusion length 

of the blade 
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CorelDRAW Output Instruction                                                                                           

The following is an example of how to output the file through CorelDRAW.  

 

User Instructions 

1. Open CorelDRAW, finish editing all the files you wish to plot and select all the images 

at once.  

 

2. Select “Outline Pen” to adjust the outline for cutting.    

 

 

3. Adjust the value of pen width to 0.001 mm and click “OK” to save your input. 
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4. Select “ File → Print” to output the file to your cutters. 

 

 

 

5. Choose the correct model you have installed. 
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6. Choose the “Layout page” and click the “Reposition images to: → Bottom left corner”. 

Please note that you must put your image at the bottom left corner. 

 

    

7. Go back to the General page and check that your image is at the bottom left corner. Click 

“Print” and get a wonderful cutting image. 
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CorelDRAW Plug-In Instruction 

 

Puma IV LX cutting plotter features AAS function, but Puma IV doesn’t. If you are Puma IV 

user, please skip this chapter. 

AASII VBA Installer is applicable for CorelDRAW Version 13, 14, 15, 16, 17, 18 

 

Installation 

Please refer to Step 8 in Chapter 2.6.1.2 Driver Installation to install AAS plug-in for 

CorelDRAW. 

 

Run CorelDRAW AAS Plug-in 

 

Step 1 Run CorelDRAW to edit your graphics and select all images at once when you wish to 

plot. 

 

Step 2 Select “ToolsMacrosRun Macro.” Then select Global Macros 

(GCCAASII_Draw13.gms) under the “Macros in” manual, and press “Run”.  
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Step 3 Click on “Apply” and select whether you would like to add the registration marks by page 

size or by object. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 4 Now you can print out the image file with registration marks. 

 

 

 

 

 

 

 

 

You can also add a Hot Icon for the AAS Plug-in 

 

Select “Tools Options Workspace Customization Commands Macros 

GCCMadual.GCC_AAS_Plug_In” and Click OK.  

  

Note: “Add Registration Mark by Object” will be the default selection if you click on 

the image whereas “Add Registration Mark by page size” will be the default one 

when the blank area on the page is clicked. 
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Add Registration Mark by page size 

 

If you tick “Add Registration Mark by page size” as shown in the figure below and click “Apply”, 

your registration marks will be created automatically (please see Figure A3-1). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The system will create the 4 marks on the 4 corners of the page as shown in the picture below 

wherever you move your image. 

  

Figure A3-1 

Figure A3-2 

Figure A3-3 

Note: 

1.  The length setting will be in the range of 5-25mm 

according to your page size. 

 

2. Please DO NOT make any changes to the “Origin” 

section when you choose to add registration marks by 

page size as indicated below otherwise the position of 

the marks will be changed (please see Figure A3-2).  
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Workable area 

It allows users to edit and cut graphics in the area outside the registration marks when adding 

registration marks by page. 

 

For A4 size media sheet, the workable area is 2.5mm extended from the registration mark on 

left and right sides and 4.5mm extended from the registration mark on top side. On the bottom 

side, it is suggested to leave at least 25mm margin from the edge of media sheet to prevent 

sheets dropping or any error occurred while media sizing. 

 

For A3 size media sheet, the workable area is 10mm extended from the registration mark on the 

left side, 9mm extended from the registration mark on the right side and 11mm extended from 

the registration mark on top side. On the bottom side, it is suggested to leave at least 25mm 

margin from the edge of media sheet to prevent sheets dropping or any error occurred while 

media sizing. 

 

 

 

 

 

 

 

 

 

 

 

 

Note: Select “Edge” mode when media sizing to allow the media sheet to be unrolled. 

If you select “Single” mode, the media sheet will not be able to be moved back and 

hence fail to be detected by front paper sensor. 
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Add Registration Mark by Object 

 

If you tick “Add Registration Mark by Object”, you will be offered three options of registration 

marks as shown below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

4-Point Positioning 

 Length: The length of marks 

 Range: 5mm~50mm 

 Optimized Setting: 25mm 

 Thickness: The line thickness of marks 

 Range: 1mm~2mm 

 Optimized Setting: 1mm 

 Margin: The distance between marks and images 

 Range: 0mm~50mm 

 Optimized Setting: 5mm 

 

Segmental Positioning 

 X Step: The distance of intermediate position on the X axis 

 Y Step: The distance of intermediate position on the Y axis 

 Range: 200mm~600mm 

 Optimized Setting: Less than 500mm 

 

Multiple Copies 

 No. of X Copies: The numbers of copies on X axis 

 No. of Y Copies: The numbers of copies on Y axis 

 Range: 1~50. (The more copies you make, the more time 

is needed for data transmission.) 

 Numbers of X Copies * Numbers of Y Copies = The total 

amount of image copies 

 Copies with outline：To show outlines of image graphics 

 

Figure A3-4 

Note: The values entered in the “4-Point Positioning” section (length, thickness and 

margin) will still be applied when you tick “Segmental Positioning” or “Multiple Copies”. 
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4-Point Positioning 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The system will create the 4 marks as shown in the picture below. 

 

 

 

 

 

 

4-Point Positioning 

 Length: The length of marks 

 Range: 5mm~50mm 

 Optimized Setting: 25mm 

 Thickness: The line thickness of marks 

 Range: 1mm~2mm 

 Optimized Setting: 1mm 

 Margin: The distance between marks and images 

 Range: 0mm~50mm 

 Optimized Setting: 5mm 

 

Figure A3-5 

Figure A3-6 
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Note:  

1. To save your materials, in addition to amending object margins, you can also adjust the 

length of the registration marks (5mm minimum) when you apply 4-Point Positioning (see 

table 1 for suggestions based on different material sizes). The smaller the size is, the 

smaller the distance between the object and the registration marks is (see the figures 

below).  

                  
 

 

 

 

 

 

 

 

 

Table 1 

*25mm is the suggested value for the registration mark length 

 

2. The size of the registration marks would affect the accuracy of registration mark detection so 

please make sure the amount you enter is reasonable.         

 

3. If you change the paper size, you will have to reset the registration marks otherwise the 

previous setting will be applied. 

 

 

 

 

Page size 

(unit: mm) 

Suggested mark length 

(unit: mm) 

A6 (105 x 148) 5 

A5 (148 × 210) 8 

A4 (210 × 297) 11 

A3 (297 × 420) 16 

A2 (420 × 594) 23 

A1 (594 × 841) and above 25* 

Area to be cut 

Figure A3-7 Figure A3-8 
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Segmental Positioning 

For precise cutting quality, it is suggested to select “Segmental 

Positioning” when you are working on an extra long or 

large-sized image to increase cutting accuracy. 

 

 

 

Segmental Positioning 

 X Step: The distance of intermediate position on the X axis 

 Y Step: The distance of intermediate position on the Y axis 

 Range: 200mm~600mm 

 Optimized Setting: Less than 500mm 

 

 

 

 

 

The system will create the as shown in the picture below 

 

 

 

 

Segmental Positioning will be applied to Multiple Copies when the object to be copied is of large 

size (with the length or width over 200mm) to increase the accuracy of registration mark 

detection. 

 

Figure A3-9 

Figure A3-10 

Segmental Positioning 
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Multiple Copies 

It is suggested to select “Multiple Copies” when you would like to make several copies of one 

image on your material to increase cutting accuracy.  

 

 

 

 

 

Multiple Copies 

 No. of X Copies: The numbers of copies on X axis 

 No. of Y Copies: The numbers of copies on Y axis 

 Range: 1~50. (The more copies you make, the more time is 

needed for data transmission.) 

 Numbers of X Copies * Numbers of Y Copies = The total 

amount of image copies 

 Copies with outline：To show outlines of image graphics 

 

 

 

The system will create the as shown in the picture below. 

 

 

 

 

 

 

X axis 

Y axis 

Figure A3-11 

Figure A3-12 
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Contour cutting through CorelDraw 

Step 1 Position the paper with registration marks printed by your printer on the GCC cutter. 

Step 2 Select “FilesPrint”. 

 

 

Note: if you use CorelDraw X5 and later, you must follow the steps below. 

 

Step 1 Click the “color” page and go to the “Color conversions performed by:” and then select 

the model name of you cutter (please refer to Figure A3-14). 

 

 

 

Figure A3-13 

Figure A3-14 
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Step 2 Go to the “Layout” page and select Bottom left corner at “Reposition images to”. 

 

 

Step 3 Click “Print”. 

Figure A3-15 
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Illustrator Plug-In Instruction 

 

Puma IV LX cutting plotter features AAS function, but Puma IV doesn’t. If you are Puma IV 

user, please skip this chapter. 

AASII VBA Installer is applicable for Adobe Illustrator Version CS4, CS5, CS6, CC. 

 

Installation 

Please refer to Step 8 in Chapter 2.6.1.2 Driver Installation to install AAS plug-in for Adobe 

Illustrator. 

 

Printer Setting 

 

Step 1 Go to Control Panel, right click on the printer and select Printer Properties to open 

the Printer Properties page 
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Step 2 Go to the Advanced page and make sure the “Enable advanced printing features” 

box is unchecked. 
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User Instructions 

 

Step 1 Open Illustrator. 

 

Step 2 Edit your image and create a contour line (Note: you must have the line width set as 

0.001mm). 

  

 

Step 3 Click on the image and apply the AAS function (FileScripts_AASII_Plug_In). 

 

 

 

 

 

Contour line 
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Step 4 Select the registration marks needed 

 

 

Step 5 Three types of registration marks are introduced here: 4-Point Positioning, Segmental 

Positioning and Multiple Copies. 

  

 

 

Step 6 Confirm the registration marks (the 4-Point Position mark is used as an illustration in the 

following steps). 

Note:  

The values entered in the “4-Point Positioning” section (length, thickness and margin) 

will still be applied when you tick “Segmental Positioning” or “Multiple Copies.” 
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Step 6 Confirm the registration marks (the 4-Point Position mark is used as an illustration in the 

following steps). 

 

 

Step 7 Click on the blank area on the page and then click “Document Setup”. 
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Step 8 Hit “Edit Artboards”. 

 

 

Step 9 Click on “Presets → Fit Artboard to Artwork bounds”. 
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Step 10 Please move your mouse to the tool bar on the left when step 9 is finished and then 

click “Selection Tool”. 

  

 

Step 11 This will take you back to the edit mode. 
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Step 12 Print out the file with the contour line and the registration marks. 

 

 

Step 13 Place the printed file on the cutter, lower the pinch rollers and then position the carriage 

at the origin of the registration marks. 

 

Step 14 Send the file to the cutter. 
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Step 15 Select the cutter model, position the object in the bottom left corner.  

 

 

Step 16 Your job is now completed. 
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Add Registration Mark by page size 

If you want to create registration mark by page size, select the object, go to “Scripts” under 

“File” and select “_AASII_Plug_In” 

 

Tick “Make by page size” and click “Apply” and the 

registration mark will be created on the 4 corners of the 

page automatically, sown as below. 

 

 

 

 

Note:  

The length setting will be in the range of 10-50mm according to your page size. 
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Workable area 

It allows users to edit and cut graphics in the area outside the registration marks when adding 

registration marks by page. 

 

For A4 size media sheet, the workable area is 2.5mm extended from the registration mark on 

left and right sides and 4.5mm extended from the registration mark on top side. On the bottom 

side, it is suggested to leave at least 25mm margin from the edge of media sheet to prevent 

sheets dropping or any error occurred while media sizing. 

 

For A3 size media sheet, the workable area is 10mm extended from the registration mark on the 

left side, 9mm extended from the registration mark on the right side and 11mm extended from 

the registration mark on top side. On the bottom side, it is suggested to leave at least 25mm 

margin from the edge of media sheet to prevent sheets dropping or any error occurred while 

media sizing. 

 

 

 

 

 

Note: Select “Edge” mode when media sizing to allow the media sheet to be unrolled. If 

you select “Single” mode, the media sheet will not be able to be moved back and hence 

fail to be detected by front paper sensor. 
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Add Registration Mark by Object 

 

If you add registration mark by Object, you will be offered three options of registration marks. 

 

Firstly, select the graphic which you want to add registration mark on and go to “Scripts” under 

“File” and select “_AASII_Plug_In”. 

 

Make sure to untick “Make by page size” and choose one of the registration mark types 

whichever is suitable. 
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Three types of registration marks 

 

4-Point Positioning 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The system will create the 4 marks as shown in the picture below. 

 

4-Point Positioning 

 Length: The length of marks 

 Range: 5mm~50mm 

 Optimized Setting: 25mm 

 Thickness: The line thickness of marks 

 Range: 1mm~2mm 

 Optimized Setting: 1mm 

 Margin: The distance between marks and 

images 

 Range: 0mm~50mm 

 Optimized Setting: 5mm 
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Note:  

1. To save your materials, in addition to amending object margins, you can also adjust the 

length of the registration marks (5mm minimum) when you apply 4-Point Positioning (see 

table 1 for suggestions based on different material sizes). The smaller the size is, the 

smaller the distance between the object and the registration marks is (see the figures 

below).  

                  
 

 

 

 

 

 

 

 

 

Table 1 

*25mm is the suggested value for the registration mark length 

 

2. The size of the registration marks would affect the accuracy of registration mark detection so 

please make sure the amount you enter is reasonable.         

 

3. If you change the paper size, you will have to reset the registration marks otherwise the 

previous setting will be applied. 

 

 

 

 

Page size 

(unit: mm) 

Suggested mark length 

(unit: mm) 

A6 (105 x 148) 5 

A5 (148 × 210) 8 

A4 (210 × 297) 11 

A3 (297 × 420) 16 

A2 (420 × 594) 23 

A1 (594 × 841) and above 25* 

Area to be cut 
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Segmental Positioning 

For precise cutting quality, it is suggested to select “Segmental Positioning” when you are 

working on an extra long or large-sized image to increase cutting accuracy. 

 

 

 

Segmental Positioning 

 X Step: The distance of intermediate position on the X 

axis 

 Y Step: The distance of intermediate position on the Y 

axis 

 Range: 200mm~600mm 

 Optimized Setting: Less than 500mm 

 

 

 

 

 

 

 

 

The system will create the marks as shown in the picture below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Segmental Positioning 
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Multiple Copies 

It is suggested to select “Multiple Copies” when you would like to make several copies of one 

image on your material to increase cutting accuracy.  

 

 

 

 

 

Multiple Copies 

 No. of X Copies: The numbers of copies on X axis 

 No. of Y Copies: The numbers of copies on Y axis 

 Range: 1~50. (The more copies you make, the 

more time is needed for data transmission.) 

 Numbers of X Copies * Numbers of Y Copies = 

The total amount of image copies 

 Copies with outline：To show outlines of image 

graphics 

 Margin: Space between marks; must be 0 or ≧ 20, 

no negative numbers allowed 

 

 

The system will create the as shown in the picture below. 

 

 

X axis 

Y axis 
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GreatCut Plug-In Instruction 

 

The user manual of GreatCut software is available on the GCC installation DVD. 

 

GCC AASII System 

Below is a step-by-step instruction of using the AAS function in GreatCut software through 

CorelDRAW and Adobe Illustrator. 

 

 

Edit your image in CorelDRAW 

 

 

 

4-Point Positioning 

Step 1 Create a new file in CorelDRAW and click on the Create contour icon on the GreatCut 

toolbar (it would appear automatically once CorelDRAW is open). 
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Step 2 Complete contour line settings (including contour offset value) and press Calculate to 

confirm. 

  

 

Contour lines will be added to the images. 

 

 

 

Contour offset is the distance 

between the object and the 

contour line. 
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Tips: Vector object to create round outline 

 

In general for vector objects you will get better results with the outline function. You will 

see the difference between "Normal" and "Round" in sharp corners. The picture is shown 

as below: 

   

 

 

1. Click the “Create outline” to create contours in a freely definable distance around text 

objects. 

  

 

2. Select “Round corners” and set the value of “offset” and “tolerance.” 

Offset is the value for the distance of the inline and outline from the original object. 

The field tolerance indicates in which offset from the corner dot is cut respectively 

rounded. 

 

 

 

 

 

 

Normal Round 
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Step 3 Press the Settings icon on the GreatCut toolbar.  

  

 

Step 4 Press the button on the right of Jog marks. 
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Step 5 Adjust the size, object margin and line thickness of your registration marks in the 

Setup-Jog Marks window and click OK. 

  

 

Step 6 Ensure the three items below are selected and click OK. 

  

 

 

 

 

 

 

4-Point Positioning 

 Size: The length of marks 

 Range: 5mm~50mm 

 Optimized Setting: 25mm 

          Object margin: The distance  

between marks and images 

 Range: 0mm~50mm 

 Optimized Setting: 5mm 

  Line thickness: the line thickness 

of marks 

 Range: 1mm~2mm 

 Optimized Setting: 1mm 

 
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Step 7 Click the Set Jog Marks icon on the GreatCut toolbar. 

 

 

The system will create the 4 marks as shown in the picture below. 

 

 



                                                          Puma IV User Manual 

GreatCut Plug-In                               A-6 

Note:  

1. To save your materials, in addition to amending object margins, you can also adjust the 

length of the registration marks (5mm minimum) when you apply the above function(see 

table 1 for suggestions based on different material sizes). The smaller the size is, the smaller 

the distance between the object and the registration marks is (see the figures below).  

                  
 

 

 

 

 

 

 

 

 

Table 1 

*25mm is the suggested value for the registration mark length 

 

2. The size of the registration marks would affect the accuracy of registration mark detection so 

please make sure the amount you enter is reasonable.         

 

 

 

 

 

 

 

 

Page size 

(unit: mm) 

Suggested mark length 

(unit: mm) 

A6 (105 x 148) 5 

A5 (148 × 210) 8 

A4 (210 × 297) 11 

A3 (297 × 420) 16 

A2 (420 × 594) 23 

A1 (594 × 841) and above 25* 

Area to be cut 
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Output 

Step 1 Select both the entire object (including registration marks and the contour line) and press 

the Cut icon on the GreatCut toolbar. 

 

Step 2 The system will activate GreatCut automatically and import the registration marks and 

contour line to GreatCut. 
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Step 3 Select Output under File. 

 

 

Step 4. Select Cut with AAS in Mode/Tool in the Output to device window. 

 

Complete the settings of AAS 

Offset, Pressure, Speed, 

Material width and so on. 
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Step 5 Click output and the object will be sent to GCC Cutting Plotter. 
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Note: The difference amount Number of outputs, Number of copies, and Step count in the 

Output window. 

 

 

1. When Number of outputs is set as 2, the square and the triangle will be cut 1 time 

and then the square and the triangle will be cut 1 time at next position. 

 

2. When Number of copies is set as 2, the square and the triangle will be cut 2 times at 

the same position. 

 

3. When Step count is set as 2, the square will be cut 2 times at the same position and 

then the triangle will be cut will be cut 2 times at the same position. 
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Advanced Settings 

 

Segmental Positioning 

For precise cutting quality, it is suggested to apply “Segmental Positioning” by adjusting the x 

and y distance when you are working on an extra long or large-size image to increase cutting 

quality. 

 

Follow the same steps in the 4-Point Positioning section to complete the contour line setting 

and registration mark creation procedures. Adjust the size, object margin and line thickness of 

your registration marks and the space between registration marks by changing X, Y distance in 

the Setup-Jog Marks window and click OK. 

 

Step 1 Press the Settings icon on the GreatCut toolbar.  
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Step 2 Press the button on the right of Jog marks. 

  

 

Step 3 Adjust the size, object margin and line thickness of your registration marks in the 

Setup-Jog Marks window and click OK. 

  

  

 

 

 

 

 

Segmental Positioning 

 Max. x Distance: The distance of 

intermediate position on the X axis 

     Range: 200-500 mm 

 Max. y Distance: The distance of 

intermediate position on the Y axis 

     Range: 200-500 mm 
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Step 4 Ensure the three items below are selected and click OK. 

  

 

Step 5 Click the Set Jog Marks icon on the GreatCut toolbar. 

 

 

 

 

 
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The system will create the marks as shown in the picture below. 

 

 

Follow the same steps in the Output section to output your image to GCC Cutting Plotter. 

 

 

Multi-Copy 

 

Step 1 Follow the same steps in the 4-Point Positioning section to complete the contour line 

setting and registration mark creation procedures.  

 

 

When you apply the “Multiple 

Copies” function, the value that 

has been set in this section will 

still be applied. 

Segmental Positioning 

X axis 

Y axis 
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Step 2 Click on the Set Jog Marks icon on the GreatCut toolbar and 4 marks will be created as 

shown in the picture below. 
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Step 3 Select both the entire object (including registration marks and the contour line) and press 

the Cut icon on the GreatCut toolbar. 

 

 

Step 4 The system will activate GreatCut automatically and import the registration marks and 

contour line to GreatCut. 
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Step 5 Select Output under File. 

 

 

Step 6 Select Mode as “Cut with AAS” and input the Number of outputs in X-direction and 

Y-direction and Distance between copies, please don’t press output button. 

 

 

Step 7 Back to CorelDRAW, Click Multi-Copy on GreatCut under File. 
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Step 8 Complete the Number in X/Y (the number of copies desired on the X/Y axis) and 

Distance in X/Y (distance between each copy) settings then click OK. Confirm that the 

value of Distance in X/Y must be the same with step 6. 

 

 

Note: The spacing of vertical & horizontal (Offset X & Y) should be ≥ 20mm or = 0mm; users are 

advised to set the Distance in X/Y as 0 mm to remove the space between each copy to 

avoid the waste of materials. 

 

Step 9 The system will create several copies of the object with registration marks as shown in 

the picture below. 
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Step 10 Print the Multi-Copy images out, and put the printed media on the GCC cutting plotter. 

 

 

Step 11 Go to GreatCut window, press Output button. 
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Edit your image in Adobe Illustrator 

 

 

4-Point Positioning  

 

Step 1 Create a new file in Adobe Illustrator.  

 
 

Step 2 Select the image and go to Contour in GreatCu in File. 
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Step 3 Complete contour line settings (including contour offset value) and press Calculate to 

confirm. 

 
 

 

Contour line is now added to the object. 

 

 

Contour offset is the distance 

between the object and the 

contour line. 
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Tips: Vector object to create round outline 

 

In general for vector objects you will get better results with the outline function. You will 

see the difference between "Normal" and "Round" in sharp corners. The picture is shown 

as below: 

   

 

 

1. Select the “Outline” in GreatCut option under File to create contours in a freely 

definable distance around text objects. 

  

 

2. Select “Round corners” and set the value of “offset” and “tolerance.” 

Offset is the value for the distance of the inline and outline from the original object. 

The field tolerance indicates in which offset from the corner dot is cut respectively 

rounded. 

 

 

 

Step 4 Click Settings on GreatCut under File. 

Normal Round 
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Step 5 Press the button on the right of Jog marks. 
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Step 6 Adjust the size, object margin and line thickness of your registration marks and click OK. 

 

 

 

 

 

 

 

Step 7 Ensure the three items below are selected and click OK. 

  

 

 

4-Point Positioning 

 Size: The length of marks 

 Range: 5mm~50mm 

 Optimized Setting: 25mm 

          Object margin: The distance  

between marks and images 

 Range: 0mm~50mm 

 Optimized Setting: 5mm 

  Line thickness: the line thickness 

of marks 

 Range: 1mm~2mm 

 Optimized Setting: 1mm 
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Step 8 Click Set Jog Marks on GreatCut under File. 

 

 

The system will create the 4 marks as shown in the picture below. 
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Output 

Step 1 Select both the entire object (including registration marks and the contour line) then click 

Cut on GreatCut under File. 

 
Step 2 The system will activate GreatCut automatically and import the registration marks and 

contour line to GreatCut. 
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Step 3 Select Output under File. 

 

 

Step 4 Select Cut with AAS in Mode/Tool in the Output to device window. 
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Step 5 Click output and the object will be sent to GCC Cutting Plotter 
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Note: The difference amount Number of outputs, Number of copies, and Step count in the 

Output window. 

 

 

 

1. When Number of outputs is set as 2, the square and the triangle will be cut 1 time 

and then the square and the triangle will be cut 1 time at next position. 

 

2. When Number of copies is set as 2, the square and the triangle will be cut 2 times at 

the same position. 

 

3. When Step count is set as 2, the square will be cut 2 times at the same position and 

then the triangle will be cut will be cut 2 times at the same position. 
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Advanced Settings 

 

Segmental Positioning 

For precise cutting quality, it is suggested to apply “Segmental Positioning” by adjusting the x 

and y distance when you are working on an extra long or large-size image to increase cutting 

quality. 

 

Follow the same steps in the 4-Point Positioning section to complete the contour line setting 

and registration mark creation procedures. Adjust the size, object margin and line thickness of 

your registration marks and the space between registration marks by changing X, Y distance in 

the Setup-Jog Marks window and click OK. 

 

Step 1 Click Settings on GreatCut under File. 
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Step 2 Press the button on the right of Jog marks. 

  

 

Step 3 Adjust the size, object margin and line thickness of your registration marks and click OK. 

 

 

 

 

 

 

 

 

Segmental Positioning 

 Max. x Distance: The distance of 

intermediate position on the X axis 

     Range: 200-500 mm 

 Max. y Distance: The distance of 

intermediate position on the Y axis 

     Range: 200-500 mm 
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Step 4 Select the Set Jog Marks on GreatCut under File and 4 marks will be created as shown in 

the picture below. 

 

 

 

 

Segmental Positioning 

X axis 

Y axis 
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Multi-Copy 

 

Step 1 Follow the same steps in the 4-Point Positioning section to complete the contour line 

setting and registration mark creation procedures.  

 

 

Step 2 Select the Set Jog Marks on GreatCut under File and 4 marks will be created as shown in 

the picture below. 

 

When you apply the “Multiple 

Copies” function, the value that 

has been set in this section will 

still be applied. 
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Step 3 Select both the entire object (including registration marks and the contour line) then click 

Cut on GreatCut under File. 
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Step 4 The system will activate GreatCut automatically and import the registration marks and 

contour line to GreatCut. 
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Step 5 Select Output under File. 

 

 

Step 6 Select Mode as “Cut with AAS” and input the Number of outputs in X-direction and 

Y-direction and Distance between copies, please don’t press output button. 

 

 

 

 

 



                                                          Puma IV User Manual 

GreatCut Plug-In                               A-6 

Step 7 Back to Adobe Illustrator, Click Multi-Copy on GreatCut under File. 

 

 

Step 8 Complete the Number in X/Y (the number of copies desired on the X/Y axis) and 

Distance in X/Y (distance between each copy) settings then click OK. Confirm that the 

value of Distance in X/Y must be the same with step 6. 

 

 

Note: The spacing of vertical & horizontal (Offset X & Y) should be ≥ 20mm or = 0mm; users are 

advised to set the Distance in X/Y as 0 mm to remove the space between each copy to 

avoid the waste of materials. 
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Step 9 The system will create several copies of the object with registration marks as shown in 

the picture below. 

 

 

Step 10 Print the Multi-Copy images out, and put the printed media on the GCC cutting plotter. 
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Step 11 Go to GreatCut window, press Output button. 
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SignPal 12 Instruction 
 

The SignPal 12 Software is Windows System compatible and all versions support the AAS 
II contour cutting function.  
 

SignPal 12 Instruction Index: 
[1] Installing the SignPal 12 software 
[2] Set up your GCC Cutter on Production Manager 
[3] SignPal AAS II Quick Start 
[4] SignPal 12 Features List 
 
 [1] Installing the SignPal 12 software 
To install the software, you must have Administrator privileges. To use the software, you 
must have Administrator or Power User privileges. See your Windows user guide for more 
information. 
 
1. Uninstall any previous version of the software. 

 
2. Go to GCC Club (http://gccf.gcc.com.tw/gccclub/login.aspx) and login, and select 

Drivers > Cutter > Others > SignPal 12 to download the WinRAR file. 

 
 
3. Follow the installation and activation instruction for SignPal 12 below. 
 

 
 
 
 
 
 
 
 

http://gccf.gcc.com.tw/gccclub/login.aspx
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(1) Install and activate software on an online computer 
 

1. Launch your browser and type https://www.saicloud.com in address bar and press 
enter, then input your activation code, then click Activate, activation code can be 
found in the code label in software package. 

 

 
2. In login section, click I am new to the SAi Cloud and input your email address, 

then click Create Account, an email will be sent to your mailbox.

https://www.saicloud.com/
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3. Check your mailbox and click website link in the email then complete the 
information fields. 
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4. Open Autorun in the WinRAR file. Then install software step by step by following 
the wizard. 

 



                                                        Puma IV User Manual 

SignPal 12 Instruction                           A-7 

5. Paste your code into activation code field. 

 
6. Select language you need, click OK and finish installation. 
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(2) Install and activate software on an offline computer 
1. Open Autorun in the WinRAR file. Then install software step by step by following 

the wizard. 
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2. Record your computer ID in the dialog box below and look up your computer name, 
You can find your computer name by right-click on My Computer and choose 
Properties. 

 

  
 
3. Launch your browser on another online computer and type 

https://www.saicloud.com in the address bar and press enter, then input your 
activation code and click Activate. 
The Activation code can be found in the software package certificate. 
 

 
 
 
 
 
 
 
 
 
 

https://www.saicloud.com/
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4. In login section, click I am new to the SAi Cloud and input your email address, 
then click Create Account, an email will be sent to your mailbox. 

 

 
 
 

5. Check your mailbox and click website link in the email then complete the 
information fields. 
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6. Click “License Manager” can’t connect and input your computer ID and 
computer name that you recorded for the offline computer before, then click 
Create license Now and Download License, save license file to local. 
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7. Copy license file to offline computer via a removable disk device, then import it. 

 

 

8. Select language you need, then click OK and finish installation. 

 



                                                        Puma IV User Manual 

SignPal 12 Instruction                           A-7 

(3) Transfer license on an online computer 

 

1. Open License Manager from Start menu. 

 

2. Click Remove License From This computer, Now you can install the software 

on another computer. 
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(4)Transfer license on an offline computer 

1. Open License Manager from Start menu. 

 

2. Click Remove License From This computer, then record removal code in license 

dialog box. 

 

 

3. Launch your browser on another online computer, access 

https://www.saicloud.com and login with your account. Click License Removed 

then input removal code and click Remove. After this you can install software on 

another computer. 

https://www.saicloud.com/
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 [2] Set up your GCC Cutter on Production Manager 

 

1. Open Production Manager 12  

2. Choose and set up your GCC cutter. 

(Note that AAS II System only works on RX II, Jaguar V LX, Puma III, Expert II LX 

models.) 
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                                                        Puma IV User Manual 

SignPal 12 Instruction                           A-7 

3. Select File > Print Setup in SignPal Software and select the printer. 
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4. Select File > Document Setup in SignPal and select paper size . 
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 [3] SignPal AASII Quick Start 

 

1. Use the Rectangle Tool to create a rectangle. 

 

 

2. Select Effect > Contour Cut. Then click ‘Apply’ in DesignCentral window. 
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3. Apply the contour cut mark of GCC AASII by selecting Effect > Contour Cut Mark.  

 

 

4. Select “GCC AASII” in SignPal DesignCentral window to create the AAS II registration 

marks (4-Point Positioning) and click ‘Apply’ in DesignCentral window.  
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5. There are three types of GCC AASII registration marks: 4-Point Positioning, Segmental 

Positioning, and Multiple Copies. To make ‘Segmental Positioning’ marks, please 

select “GCC Segmentation” in DesignCentral window and then click ‘Apply’.  

 

 

6. For ‘Multiple Copies’, this function is not available in SignPal. Currently the ‘Multiple 

Copies’ function is only available under CorelDraw plug-in. 

 

7. Select File > Print to print out the image. 
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8. Set the Scale as 100% in Print page. 

 

 

9. Load the printout vinyl on the plotter and select File > Cut Contour to send data. You 

can preview the job and change cutter’s parameter settings in ‘Properties’ tab of Cut 

Contour window. The Production Manager will be automatic activated to complete the 

job. 
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 [4] SignPal 12 Features List 

 Expert Apprentice 

Text   

Text Tool ● ● 

Arc Text ●  

Path Text ●  

Vertical Text ● ● 

Vertical Path Text ●  

Kerning ●  

Break Apart/ Join ● ● 

   

Drawing   

Bezier ● ● 

Freehand Drawing ● ● 

   

Shapes   

Rectangle ● ● 

Oval ● ● 

Registration Mark Tool ● ● 

Measure Tool ● ● 

   

Path Editing   

Select Point Tool ● ● 

Remove Point ●  

Add Point ●  

Straighten Path ●  

Round Corner ●  

Sharpen Corner ●  

Optimize by Curve ●  

Optimize by Smooth 

Arc ●  

Optimize by 3point Arc ●  

Make Arc ●  

Reduce Points ●  

Close Path ●  

Change Start Point ●  

Cleaver ●  
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Scissors ●  

Make Right Angle ●  

Break Path ●  

Join Paths ●  

Align Horizontal ●  

Align Vertical ●  

Align Points ●  

Apply Length and 

Angle ●  

Remove Tiny Objects ●  

Vector Eraser ●  

Cleaver by Path ●  

   

Working with Files   

Job Info ●  

Scanning ●  

Achieve to Cloud ● ● 

Workspaces ● ● 

   

View   

DesignCentral ● ● 

Color Mixer ● ● 

Snap ● ● 

   

Arrange   

Group ● ● 

Compound ● ● 

Mask ● ● 

Guides ● ● 

Contour Cut ● ● 

Convert to Outlines ● ● 

Convert Stroke to 

Outlines ● ● 

Convert Linked to 

Native ● ● 

Path Direction ● ● 

Order ● ● 

Cut Order ● ● 
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Align ● ● 

Spacing ● ● 

Rotate ● ● 

Resize ● ● 

Deskew ● ● 

Mirror ● ● 

Step and Repeat ●  

   

Effects   

Combine ●  

Outline ●  

Contour Cut ● ● 

Contour Cut Mark ● ● 

Shadow ●  

   

Bitmap   

Autotrace ●  

Color Mode ●  

   

Production    

Cut/Plot ● ● 

Manual Split Lines ● ● 

Tile All Copies ● ● 

Panel to Border ● ● 

Auto-weld ● ● 

Auto-trap ● ● 

Overcut ● ● 

Optimize Cutting Order ● ● 
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Sure Cuts A Lot 

 

There are basic instructions of Sure Cut A Lot below. If you need detailed instruction, please 

refer to Sure Cut A Lot Help.  

 

1. Select the cutter you want to output and change the work area. 

 

Step 1 Run Sure Cuts A Lot software. 

  

 

Step 2 Select “Cutter” and select “Manage Cutters” under My Cutter to change the work 

area. 
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Step 3 Select company / brand as GCC and select model you want to output and then click 

the “<--Add to list” button. 

 
 

Step 4 Select GCC on the left and click “Done.” 

 

 

Step 5 If you want to change the material size and orientation, you can fill a proper value in 

the Document window.  
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2. Insert Graphics from Library  

Step 1 Select graphics from library to insert a selected design. 

 

 

3. Draw Text 

Click on the T icon at left side to create the text and select the font you like at text window.  
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4. Import Design 

If you have created your design in other design software, go to “import” or “place image” 

under file to import it, SCA supports svg, scut, scal, pdf, ai. wpc eps, bmp, gif, jpg and png 

files. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Tips Thousands of SVG files designed specifically for Sure Cuts A Lot! 

 http://SVGCuts.com is the top of source for designer SVG files for Sure 

Cuts A Lot. Thousands of high quality elements including: shapes for 

card-making, scrapbooking, as well as gift bags, boxes and 3D flowers. 

http://svgcuts.com/
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5. Convert Image to Cutting File 

Step 1 Go to Trace Image under File, or select Trace Image button on the toolbar to open 

the setting window. 

 

 

Step 2 Click on “Choose an image” to input the image, adjust Image Settings and Output 

Settings, and click OK. Then the outline of the image will be outputted automatically. 

 

 

 

 

 

 

 

Note 

 The contrast and pixels of import images will affect the trace 

image result. High contract graphics are recommended. 
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6. Cut the Design 

Step 1 Click on the “Cutter” button on the toolbar and Cut Settings window will appear. 

 

 

Step 2 Click on “Settings…” to open GCC Cutter Settings window. 

 

 

 

 

 

Step 3 Adjust Registration Marks setting under GCC Cutter Settings window if needed.  

 

 

 

 

 

*Registration Marks: set the distance between the edge of the material 

and the registration marks in Mark Offset; set the size of marks in Mark 

Size; set the line thickness of marks in Mark Thickness. 

 

Note 

 The origin point is on the bottom right. 
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Step 4 Adjust Blade Offset, Overcut Value, Multi-Cut and Quality under Cut Settings window 

if needed.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

*Blade Offset: set the offset value according to different blade, for a 

standard blade, set the offset value at 0.25mm, 0.5mm for an optional 

advanced blade and 0mm for an optional plotting pen. 

  

*Quality: associated with the cutting result; please note the better 

cutting quality, the slower cutting speed. 

 

*Multi-Cut: to repeat the cutting job at same position which is suitable 

for cutting thick material. 

 

*Overcut: allows for easier weeding and makes up for incomplete cut 

lines. 
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Step 5 Under “Cut Settings” section, there are some useful functions. After setting the 

parameters, click on “Cut” to send the data to the GCC cutter and the GCC cutter will 

start the cutting job. 

    

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

*Cut Mode: there are “WSIWYG” and “Origin Point” options, WSIWYG 

means what you see is what you get, the cutter will output the graphic 

at same position in preview window. While with Origin Point mode, the 

cutter will cut the graphic from bottom right origin point of the material.  

 

*Use Software Speed and Pressure: tick this section, and you can set 

the values of speed and pressure manually.  

 

*Preset: select a proper material to apply the preset speed and 

pressure parameter automatically. 

 

*Speed & Pressure: you may adjust values of speed and pressure 

manually to get quality results. 
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7. Print and Cut Your Design 

The Print and Cut function allows you to print the graphics from Sure Cuts A Lot to printer, 

and then put the printed materials on the GCC cutter to cut out the contour of printed jobs 

from Sure Cuts A Lot.  

 

Step 1 Open an image file in Sure Cuts A Lot.  

 
 

Step 2 Click on the Cutter icon on the toolbar, set the parameters and click on “Print+Cut” to 

add the registration marks and print out the image. 
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Step 3 Click on “Print…” to open printer setting window and click OK. 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 4 Print your design with registration marks out.  

 

 

Step 5 Load the printed media to the GCC cutter. 

 

Step 6 Press “Next” and then press “Scan+Cut”, and then the GCC cutter will detect the 

registration marks and cut the contour lines automatically. 
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Tips Test Connection function can save your materials. 

 Click on “Test Connection” to exam if set the connection properly.  
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